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 مقدمه

 را کااربردی  هاای  برناماه  و کامپیوتری های شبکه برای عملکرد مدیریت که است افزاری نرم OPNET آوری فن 

 بهیناه  منظاور  باه  ارشاد  کارشناسی پروژه انبعنو را OPNET افراز نرم MIT دانشجوی کوهن نماید،آلن می فراهم

 تصامیم  بارانیوک، استیون اش همکلاسی و  مارک برادرش همراه به آلن. نمود تولید شبکه مهندسی ابزارهای سازی

 نارم  ابازار  یاک  بعناوان  کاه  بود  OPNET Modeler شرکت این محصول اولین. نمود افزار نرم نمودن تجاری به

 .رفت می بکار کامپیوتری های شبکه سازی بیهش و سازی مدل برای افزاری

 دیگر با آن اصلی تفاوت. باشد می ای شبکه نوع برای هر عملکرد و رفتار سازی شبیه ابزار یک OPNET ساز شبیه

 .سازد می ممکن OSI مدل با کار برای را ساز شبیه این که است آن پذیری تحبیق قدرت ها سازی شبیه

 قادرباه  کتااب  ایان  محالعه با ، مخاطب شده گرفته نظر در سازی شبیه ابزار دانش حداقل داشتن بر فرض کتاب این در

 ایان  .باشد می کامپیوتری های شبکه سازی شبیه عملیات جهت افزار نرم این های گزینه و ابزارها از استفاده و درک

 یاادگیری  و درک کتااب  ارياه از هدف.  است شده ارايه کاربردی آزمایشگاه چهارده به مراه فصل دوازده در کتاب

 عملکارد  سازی شبیه شبکه، بهینه طراحی سازی، شبیه طریق از فعلی های شبکه آنالیز نظیر OPNET مهم کاربردهای

 .می باشد ... اند و آمده وجود به تحقیقاتی های محیط در که جدید های پروتکل

 شابیه  ساناریوهای  ایجاد جهت ابزارها معرفی به فصول ادامه در و پرداخته OPNET اساسی مفاهیم به اول بخش در 

 مای  بیاان  هاا  ساازی  شبیه در OSI مدل لایه سازی پیاده  جهت را افزار نرم این از استفاده نحوه و پردازیم می سازی

 قالاب  در ساناریوها  ازاراياه  هادف . بریم می پایان به کاربردی سناریوی چهادر ارايه با را کتاب بخش آخرین .نماییم

 OPNET افازار  نارم  اساسای  مختلف های ویژگی با کار تمرین به شما دهیم اجازه که است این مایشگاهآز چندین

 ایجاد ،OPNET سازی شبیه پروژه یک اندازی راه عنوان به OPNET ای پایه عملیات با خاص، طور به بپردازید،

 آشنا...و آمار مقایسه و سناریو، ریتمدی آن، اجرای سازی، شبیه آمار آوری جمع ، اشیاء پیکربندی شبکه، توپولوژی

 .گردید
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1-1.OPNET IT GURU  وModeler 
حل برای  کننده راه سازی شبکه و ارايه افزار شبیه از پیشگامان توسعه نرم OPNETهای آوری شرکت فن

افزاری این شرکت به طور  محصولات نرم. ی کاربردی و مدیریت شبکه استها مسايل مربوط به برنامه

زدایی  در حال ظهور شبکه، ارزیابی عملکرد، تست و اشکال یها یآور فنای برای تحقیق و توسعه  گسترده

های  ها و دانشگاه های کاربردی و جهت تدریس و پژوهش در دانشکده ها، برنامه های ارتباطی، پروتکل شبکه

افزاری و تعداد  در حال حاضر بیش از یک دوجین محصولات نرم OPNET. گیرد مورد استفاده قرار می ددمتع

توانند به راحتی برای محالعه و ارزیابی تقریباً  کند که می ها را فراهم می های تخصصی و مدل شماری از ماژول بی

 .همه الگوهای شبکه امروزی، بکار گرفته شوند

های  تواند برای پیکربندی شبکه رای یک رابط گرافیکی ساده برای کاربر است که میدا OPNETافزار  نرم

این . ، با عملیات ساده کشیدن و رها کردن ماوس و یا چند کلیک، بکار رودها آنمختلف و تست عملکرد 

و افزاری موجود  سخت یها دستگاههایی است که بسیاری از  افزار شامل یک کتابخانه بزرگ از مدل نرم

سازی این امکان را برای شما  های شبیه ای از مدل چنین فراوانی. کند سازی می های ارتباطی را شبیه پروتکل

های  سازی کنید و به روزترین پروتکل های کامپیوتری را شبیه ترین شبکه کند که به راحتی پیچیده فراهم می

 .ارتباطی را پیکربندی کنید یها یآور فن

OPNET IT Guru  وOPNET Modeler هر دوی این . سازی شبکه هستند های شبیه ترین بسته محبوب

ساخته شده از  های از پیش های کامپیوتری مختلف با استفاده از مدل محصولات به شما اجازه محالعه شبکه

 IT با این حال برخلاف. دهد ای متداول را می های شبکه آوری ها و فن وسایل ارتباطی مختلف، پیوندها، پروتکل

 Guru ،Modeler های   سازی و تغییر مدل های شبیه های اضافی است که به شما اجازه ایجاد مدل دارای قابلیت

 .دهد موجود را می

OPNET و  هاا  دانشاگاه افزاری و پشتیبانی فنی رایگان را برای  یک برنامه دانشگاهی دارد که مجوزهای نرم

، بساته نارم افازاری    OPNETاز طریاق برناماه دانشاگاهی    . کند های واجد شرایط تمام جهان فراهم می دانشکده

 . به صورت رایگان دانلود شود تواند یم، IT Guru 6-3،  بر اساس  نسخه تجاری IT Guruنسخه آکادمیک

 .شودپشتیبانی می Redhatبه وسیله سیستم عامل ویندوز و لینوکس  Modelerو  IT Guruدر حال حاضر،



 

  

 OPNET IT Guru و Modelerنصب .1-1-1

  بارآورده را  سیساتم مشاخ  شاده    یها یازمندین، باید محمئن شوید که کامپیوتر شما OPNETبرای نصب 

بر روی سی دی و یا بر روی وب ارايه شده اسات   یها لیبا فاهای نصب که همراه و سپس دستورالعمل کند یم

 :ورت زیر استبه ص Modelerو IT Guruنصب یها روالبه طور کلی، . را دنبال کنید

 .نصب مستندات محصول .OPNET        .1 یها مدلنصب  .0                 .نصب محصول نرم افزاری. 3

 (Modelerبرای  فقط + + C / C(لریکامپاپیکربندی . ۳        .شروع و پیکربندی سرویس دهنده مجوز. 0

 (.شود نظر صرف تواند یم)پیکربندی مرورگر وب برای مشاهده مستندات نرم افزار.  9   

در طول مرحله نصب و راه اندازی نرم افزار، ، ممکن است نیاز به مشخ  کردن نوع سیستم صدور مجوز 

تواند تنظیم شود را توضی   های مجوز را که در زمان نصب می بخش زیر حالت. بر روی کامپیوتر شوید

 .دهد می

 OPNETدهنده مجوز  سرویس. 2-1-1
یک مجوز برای هر نمونه از اجرای : باید قبل از نصب دارای مجوز باشند OPNETهمه محصولات 

اگر .شود دهنده مجوز ارتباط برقرار می کنید با سرویس را اجرا می OPNETهنگامی که شما . OPNETافزار  نرم
نظر را تخصی  داده و د دهنده مجوز، مجوز مور افزار درخواست شده موجود باشد، سرویس مجوزهای نرم

افزار قادر به اجرا نخواهد  صورت درخواست رد شده و نرمن در غیر ای. شود آغاز می OPNETرای اج
به طور معمول، . های مجوز است دهنده مجوز در واقع یک فرایند مسئول برای مدیریت درخواست سرویس.بود

دايم در پس زمینه  تبه صورشود و  خودکار هنگام بالا آمدن کامپیوتر اجرا می به صورتدهنده مجوز  سرویس
 .ماند در حالت اجرا باقی می

 :های مجوز زیر پیکربندی کنید را برای پشتیبانی یکی از حالت OPNETتوانید  شما می
1. standalone(مستقل) : در این حالت تنها . کند دهنده مجوز عمل می سرویس به صورتکامپیوتر جاری

 .کند شود را مدیریت می های مجوزی که از همین کامپیوتر صادر می درخواست
2. Floating: serve licenses from this computer‌(سرویس‌دادن‌مجوز‌از‌این‌کامپیوتر‌-شناور)‌: کامپیوتر
های صادر شده از این کامپیوتر و یا  کند و درخواست دهنده مجوز شبکه عمل می سرویس به صورتجاری 

افزار شبکه را مدیریت  برای مدیر سیستم که نرماین گزینه . شود دیگر کامپیوترها در شبکه مدیریت می
 .شود فعال است، توصیه می OPNETدهنده مجوز همواره برای کاربران  کند و با اطمینان از اینکه سرویس می

3. Floating: access licenses from remote server‌(دهنده‌راه‌دور‌دسترسی‌مجوزها‌از‌سرویس‌-شناور) :
دهنده  کند و برای بدست آوردن مجوز با سرویس عمل می رندهیگ سیوسر به صورتکامپیوتر جاری 

 .کند مجوز که کامپیوتر دیگری بر روی شبکه شما است، ارتباط برقرار می



 

 

برای . سرور مجوز را مشخ  کنید پورتو شماره  IPوقتی این گزینه انتخاب شود، شما باید آدرس 

این گزینه معمولاً هنگامی . تان تماس بگیرید مدیر شبکه توانید با دهنده مجوز می دریافت اطلاعات سرویس

 .در شبکه شما پیکربندی شده و در حال اجرا است OPNETدهنده مجوز  شود که یک سرویس استفاده می

OPNET خاتمه ۱ کند که به مدیر شبکه اجازه شروع همچنین یک ابزار مدیریت مجوز را فراهم می

 .دهد افزار و انجام سایر وظایف مدیریت مجوز را می مجوزهای نرمحذف ۱ ، اضافه OPNETدهنده  سرویس

 های ایجاد شده پس از نصب پوشه. 3-1-1

هاای   یکای از پوشاه  . کناد  چندین پوشه را بر روی کامپیوتر شاما ایجااد مای    OPNETدر زمان نصب اولیه، 

است و معماولاً   OPNETت پوشه های سیستمی اس ها، اسناد و فایل افزار، مدل کلیدی که شامل اجزاء واقعی نرم

در  C:\Program Filesکناد قارار دارد، مانناد     های کاربردی خود را ذخیره می در جایی که سیستم عامل برنامه

 :کند یمچندین پوشه شامل اطلاعات خاص کاربر تولید  OPNETبه علاوه . ویندوز

 OP_Admin‌: هاای   شاود، مانناد فایال    مای  خودکاار تولیاد   به صورتاین پوشه حاوی اطلاعاتی است که

و فایل پیکربندی محایط   LOGهای مختلف  ، فایل(tmpپوشه ر زی)های موقتی  ، فایل(bkزیر پوشه )پشتیبان 

 .کنیم یاد می adminاست، ما از این پوشه به عنوان  OPNETافزار  افزار که شامل تنظیمات نرم نرم

 OP_Models‌:سازی ایجاد شده توسط کاربر در آن  ی شبیهاین پوشه پیش فرضی است که فایل پیکربند

های  سازی فایل همچنین اجازه ذخیره OPNET. های پروژه دارد شود، که معمولاً اشاره به فایل ذخیره می

 .دهد را می OP_Modelsفرض  پروژه را در محلی غیر از محل پیش

 OP_Reports:  این پوشه پیش فرضOPNET سازی اسات  های شبیه برای ذخیره کردن گزارش .OPNET 

را  3 -0بخاش  )دهاد   تغییر در تنظیمات می لهیبه وسها را  سازی پیش فرض گزارش اجازه تغییر محل ذخیره

 (.ببینید

 های اختیاری فعال سازی ماژول. 4-1-1
هااای اختیااری کااه   توانااد مجوزهاای مااژول   مای  OPNETهااای آوری بار اسااس درخواساات، شارکت فان    

سازی ناحیه جغرافیایی، نمایش سه بعدی شبکه، اتوماسایون و غیاره را    فی از قبیل مدلافزاری اضا های نرم قابلیت
( ب)شاکل  )های محصول  اگر شما چنین مجوزهایی داشته باشید یک پنجره انتخاب ماژول. دهد، صادر کند می

 .شود، نمایش داده خواهد شد برای اولین بار اجرا می OPNETهنگامی که ( 3 -3
ها را نشان  سازی ماژول فعال ، طریقهمراحل زیر .شود اجراهای بعدی دیگر نمایش داده نمیاین پنجره برای 

 :دهد می
 (3 -3(ب)شکل . )برای انتخاب و یا عدم انتخاب کلیک کنید رنظد های مور بر روی جعبه انتخاب ماژول 
 .کلیک کنید OKبرای بستن پنجره روی دکمه  
 .دوباره اجرا کنید را ببندید و OPNETبرای اعمال تغییرات  



 

  

توانید  های خاصی را در اولین اجرا فعال کنید، بعدها از طریق مراحل زیر می اگر فراموش کردید که ماژول
 :این کار را انجام دهید

 OPNET را اجرا کنید. 

 
 OPNETمحصول در پنجره آغازین  یها ماژولگزینه ( الف: )OPNETهای  ماژول 1 -1شکل 

Modeler(ب )ها تخاب ماژولپنجره ان 

 .(3 -3 (الف)شکل )انتخاب کنید  licenseرا از منوی  product modulesگزینه  
سازی ماژول مورد نظر  مراحل فوق را برای فعال. شود ظاهر می select product modulesحال پنجره  

 .تکرار کنید

 OPNETمدیریت تنظیمات  .2-1
OPNET (اندازهرنگ و )از قبیل رفتار سیستم، قابلیت، ظاهر افزاری  به شما اجازه تغییر تنظیمات نرم ،
به تر، تنظیمات  برای جستجوی ساده. دهد های مدل و غیره را می های کاربردی، محل پوشه پشتیبانی برنامه
برای . دارد Tagبه نام  فنیپسند و یک نام ر هر گزینه یک نام کارب. اند دهی شده بندی شده سازمان دسته صورت
 پسندر کند، نام کارب را مشخ  می OPNETای که برنامه مورد استفاده برای نمایش مستندات  نهمثال، گزی

Path to Document Viewer Program  فنیو نامVudoc- Prog دارد. 
توانید مقدار  تغییر یافته است، شما می Htmlبه بعد به فرمت  12.0از آنجايیکه مستندات برنامه از نسخه 

 .نظرتان تغییر دهید و یا دیگر مرورگرهای وب مورد Firefoxرا به  Vudoc- Progاولویت 

 ویرایشگر تنظیمات. 1-2-1
. نشان داده شده، تغییر کند 3 -0که در شکل  Preferences Editorتواند از طریق  می OPNETتنظیمات 
که در بالای  Search Forیک جعبه متن جستجو با نام . شامل پنج قسمت است Preferences Editorپنجره 

شما . دهد این جعبه اجازه جستجو در تنظیمات را به وسیله نام، مقادیر و یا همه اطلاعات می. پنجره قرار دارد



 

 

و یا   In values, In Namesتوانید نوع جستجو را به وسیله انتخاب یکی از مقادیر لیست بازشونده می
Anywhere با کلیک روی دکمه . مشخ  کنیدFind تان را آغاز کنید وانید جستجویت می. 

 Sourceو یا ( OPNETهای مشترک پیکربندی  بندی برای جنبه مانند دسته) Groupsتوانند با  تنظیمات می

 .باشد( مانند محلی که مجموعه به خصوص از تنظیمات از قبیل مسیر کامل فایل پیکربندی تعریف شده است)

مرتاب   Groupsفرض تنظیمات باه وسایله    پیش به طوراست، نشان داده شده  3-0که در شکل  یطور همان

شامل یک درخت مشاهده، از تنظیمات ساازماندهی   Preferences Editorبخش سمت چپ پنجره . شده است

بارای   –یاا  + توانید این درخت را به وسیله کلیک بر روی علامت  شما می. ها یا منابع هستند شده به وسیله گروه

کلیک بر روی یک شاخه درخات هماه تنظیماات متعلاق باه      . های درخت مرور کنید شاخه باز کردن و یا بستن

 .دهد واقع در سمت راست پنجره را نشان می preferences Tableگروه و یا منابع انتخاب شده در 

 
 Preferences Editorپنجره  1 -2شکل 

ر که شامل نام یک تنظیم کارب ،nameستون : فرض جدول تنظیمات حاوی تنها دو ستون است به طور پیش

دو ستون  Advanced Viewبا انتخاب جعبه . که حاوی مقدار واقعی یک تنظیم است valueپسند است و ستون 

دهنده جایی است که یک گزینه  نشان Sourceتنظیم است و ستون  فنیکه نام  Tagستون . شود دیگر اضافه می

که در سمت راست پایین  Preferences Informationبخش  .شود تعریف می Preferences Editorخارج از 

 .دهد جدول تنظیمات قرار دارد توضی  کاملی از گزینه انتخاب شده را نشان می

 :های استاندارد در پایین پنجره قرار دارند ای از دکمه در نهایت مجموعه

 

 Ok پذیرفتن تغییرات و بستن پنجره



 

  

 Apply جرهاعمال تغییرات و باز نگه داشتن پن

 Cancel بستن پنجره بدون ذخیره کردن تغییرات

 Help .دهد باز کردن یک پنجره راهنما که جزيیات توصیف پنجره تنظیمات را نشان می

 تغییر مقادیر تنظیمات. 2-2-1
 :دنبال کنید OPNETمقادیر تنظیمات  رییتغمراحل زیر را برای مشاهده و یا 

 OPNET را اجرا کنید. 

 .شود یمباز   Preferences Editorپنجره  را انتخاب کنید، Editگزینه   Preferencesاز منوی  

 :گزینه برای تغییر  مقدار یک 

  روی فیلدValue مربوطه درPreferences Table کلیک کنید. 

 از گزینه  دیتوان یمدر برخی مواقع . مقداری را از منوی باز شده انتخاب کنیدEdit…  استفاده کنید
 .دهد یمشما اجازه تایپ یک مقدار را که به 

 .برای اعمال تغییرات کلیک کنید Preferences Editorدر   OKروی دکمه  

 فایل تنظیمات محیط برنامه. 3-2-1
OPNET  مقادیر تنظیمات را در یک فایل در پوشهAdmin برای مشخ  کردن محل . کند نگهداری می

 :این پوشه، مراحل زیر را دنبال کنید
 OPNET را باز کنید. 
 Environmentرا انتخاب کنید و بر روی عنوان  About This Applicationگزینه  Helpاز منوی  

را باز کنید که شامل توصیف کوتاهی از پارامترهای  System Informationبندی  سپس دسته. کلیک کنید
 (.را ببینید 3 -1شکل )است  Adminکلیدی سیستم از جمله محل پوشه 

نسخه  verاست که منظور از  <env-db<verشامل فایل تنظیمات محیط سیستم با نام  Adminپوشه 
OPNET به عنوان مثال . مورد استفاده استOPNET  دارای فایل محیط برنامه به اسم 15.0نسخهenv-db15.0 
 .خواهد بود



 

 

 
 OPNETتنظیمات محیط  1 -3شکل 

به های مورد استفاده قرار گرفته  یر بیشترین گزینهها و مقاد شامل نام OPNETفایل محیط محتوایات 
 .تواند با هر ویرایشگر متنی باز شود و تغییر یابد این فایل می. متن ساده است صورت

 مشاهده مستندات . 3-1
OPNET افزار  های موجود در نرم کند که شامل شرحی از قابلیت مستندات محصول را با جزيیات فراهم می

 .ای از محالب و لینک به منابع مختلف وب است موعهو همچنین شامل مج
مستقیم با مرورگر وب که  به صورتتواند  شود که می ذخیره می HTMLدر یک فایل  OPNETمستندات 
Java Script های  و قالبHTML توانند  جایگزین، مستندات می به صورت. را پشتیبانی کند، نمایش داده شود
 (.را ببینید 3 -0شکل )نمایش داده شوند  HELP از منوی OPNETاز پنجره اصلی 
آن چندین قابلیت . بندی شده است های آن دسته قسمتر های موضوعی و زی به فصل OPNETمستندات 

ها  های سریع، باز و بسته کردن عناوین فصل نامه، لینک شامل جستجو، شاخ ، واژه( را ببینید 3 -۳شکل )مفید 
 یابی دستافزار،  های مختلف استفاده از نرم ها برای جنبه کردن توضیحات روال ها، نمایش و مخفی قسمتر و زی

 .دهد های دیگر را می و بسیاری از قابلیت PDFافزار با فرمت  به فصول مستندات نرم

 های مدل ها و پوشه کار با فایل. 4-1
ا باز کنید و یا یک فایل سازی، شما نیاز دارید تا یک فایل موجود ر های مختلف محالعه شبیه از دیدگاه

های  با انواع فایل Modelerو  IT Guruهر دو برنامه . را در یک پوشه ذخیره کنیدن جدید ایجاد کنید و آ
های جمع شده در طی اجراهای  سازی و داده های شبکه مورد استفاده را در شبیه کنند که مدل مختلفی کار می

 .کند سازی را ذخیره می شبیه
هاای داده گرافیکای،    هاای پاروژه، فایال    از قبیال فایال  )محدودیتی برای انواع فایال دارد   IT Guruاگر چه 

دهاد، در حاالی کاه     هاا نمای   ای در مادل  سازی تغییر اساسی ، که در ایجاد یک محالعه شبیه...(های آماری و مدل



 

  

Modeler ساازی شاده و    بیههاای شا   هاای دساتگاه   ساازی  هاا، شاامل پیااده    تری از اناواع فایال   طیف وسیع دارای
هاای پاردازش، هادرهای     هاای گاره، مادل    تواند به مدل می Modelerبه خصوص . باشد یمشبکه  یها یآور فن

 .داشته باشد یابی دستسازی و غیره  های پیاده ، فایل++C/Cخارجی 

 های انتخاب فایل حالت .1 -4 -1
فایال را بارای بااز کاردن یاک       به بعد، دو روش مختلف مارور  30. 2، از نسخه OPNETهای جدید  نسخه

 :اند فایل، فراهم کرده
1. General File Chooser ( 3  -9 (الااف)شااکل :)   یااک مرورگاار کااه اجااازه جسااتجوی همااه وسااایل
 .دهد که مانند مرورگر فایل معمول در سیستم عامل است سازی متصل به کامپیوتر جاری را می ذخیره

2. File Choose Organized by Model Directories ( 3  -9 (ب)شکل :)های  یک مرورگر که تنها پوشه
هساتند، باا    OPNETهای  هایی هستند که شامل لیستی از مدل پوشه ها نیا. دهد را نشان می OPNETشناخته شده 

 .شود تر می نظر سریعد شود و بنابراین فرایند انتخاب فایل مور های موجود کمتر می انتخاب این حالت، گزینه

 
 .Help منوی 1 -4شکل 

 
 OPNETمستندات  1 -5شکل 



 

 

فرض است و در همه  حالت پیش (دوم حالت) " های مدل سازماندهی شده با پوشه"حالت انتخاب فایل 
. به بعد وجود دارد 30. 2های  در نسخه( اولحالت )حالت انتخاب فایل کلی . موجود است OPNETهای  مدل
در . بر آیکون گوشه پایین سمت چپ پنجره سويیچ کنیدهای فوق با کلیک کردن  توانید بین حالت شما می

 (الف)شکل )یک مربع آبی با یک ستاره سفید در داخل آن است  به صورتحالت انتخاب فایل کلی، آیکون 
، آیکون یک مربع تقسیم شده به چهار ”های مدل سازماندهی شده توسط پوشه“در حالت انتخاب فایل (. 3 -9

 .(3-9 (ب)شکل . )مربع چند رنگ است
، که گاهی به میزان دهد یمها بر اساس نوع فایل را  در هر دو حالت انتخاب فایل شما اجازه انتخاب فایل

های  و یا دیگر فایل ++C/Cقابل توجهی زمان مورد نیاز برای جستجوی یک پروژه، مدل پردازش، کد خارجی 
OPNET دهد را کاهش می. 

 های مدل اضافه کردن پوشه .1 -4 -2

گاهی شما . است OP-Modlesهای مدل، پوشه  برای ذخیره کردن فایل OPNETوشه پیش فرض پ

های پروژه را در یک درایو خارجی و یا در محلی به غیر از پوشه پیش فرض مدل ذخیره  خواهید که فایل می

این کار . داضافه کنی OPNETهای مدل  در چنین مواردی، شما باید پوشه مورد نظر را به لیست پوشه. کنید

 .دهد خارج از پوشه پیش فرض را می OPNETهای ذخیره شده  اجازه دسترسی به فایل

های مدل مفید است زیرا هنگامی که  این قابلیت به خصوص هنگام کار کردن با حالت انتخاب فایل با پوشه

شه با این حالت های موجود در پو شود، همه فایل اضافه می OPNETهای مدل  یک پوشه جدید به لیست پوشه

 .شود می مشاهدهانتخاب فایل 

 
انتخاب فایل سازماندهی شده با ( ب)انتخاب فایل کلی ( الف)OPNETپنجره انتخاب فایل  1 -6شکل 

 های مدل پوشه

را در زیر  ها آنما چند تا از . های جدید مدل وجود دارد چندین روش مختلف برای اضافه کردن پوشه

 :دهیم شرح می

را انتخاب کنید، پنجره جدیدی به نام  File >Manage Model Files> Add Model Directory:‌1روش‌

Browse For Folder پوشه جدید را برای اضافه شدن انتخاب کنید و روی دکمه . شود باز میOK  کلیک



 

  

دو  شود که حاوی نشان داده شده است ظاهر می 3 -2که در شکل  Confirm Model Directoryپنجره . کنید

 :جعبه انتخاب است

 Include all Subdirectories :ن های آ پوشهر انتخاب این گزینه نه تنها پوشه انتخاب شده بلکه همه زی

 .کند را شامل می

 Make The Default Directory :سازد، به  فرض می انتخاب این گزینه پوشه انتخاب شده را پوشه پیش

برای اضافه شدن پوشه  OKبر روی دکمه .شوند پوشه ذخیره می های جدید در این این معنی که همه فایل

 .انتخاب شده کلیک کنید

تغییار   Preferences Editorرا از Model Directoriesافازار باه ناام     نارم  نظایم این روش ویژگای ت  :8روش

بار روی   Editاز مناوی  .ناام داشات   mod-dirایان ویژگای    OPNETهاای قادیمی    در برخی از نساخه . دهد می

Preferencesکلیک کنید .Preferences Editor ویژگی . شود باز میModel Directories  را جستجو کنید و

 .را در پایین پیدا کنید Model Directoriesرا باز کنید و ویژگی   Miscellaneousیا گروه 

که لیستی  Model Directoriesیک پنجره . کلیک کنید Model Directoriesبر روی مقدار فیلد ویژگی 

 .شود های در حال حاضر اضافه شده است باز می از همه پوشه

 
 Confirm Model Directoryپنجره  1 -7شکل 

به طور . ای که باید در لیست اضافه شود را تایپ کنید کلیک کنید و مسیر کامل پوشه Insertبر روی دکمه 

یا  Workingگیرد، آن را به حالت  ار میای که جدیداً اضافه شده است در بالای لیست قر فرض پوشه پیش

Default Directory اگر شما در ابتدا یک پوشه را در لیست قبل از . ببریدInsert  ،کردن انتخاب کرده باشید

 .آید پوشه جدید درست قبل از پوشه انتخاب شده می

 یکار دستت را های لیس توانید گزینه می Move Downیا  Delete ،Move upهای  با کلیک کردن دکمه

 .کلیک کنید OKبر روی  دوبارهبرای پذیرفتن تغییرات . و مرتب کنید

در فایل تنظیمات  Mod-Dirsهای مدل ویرایش دستی مقدار ویژگی  روش دیگر برای اضافه کردن پوشه

 .است OP-Adminمحیط واقع در پوشه 

 <Fileخوبی است که روی گزینه های فوق، پس از اینکه پوشه اضافه شد، این ایده  در هر یک از روش

Manage Model Files > Refresh Model Directories  کلیک کنید تاOPNET های اضافه شده  از فایل



 

 

 Mod-Dirsهای لیست شده در ویژگی لحفاً توجه داشته باشید که ترتیب پوشه. های جدید محلع گردد در پوشه

های پروژه و مدل بکار  های حاوی فایل برای جستجوی پوشه OPNETافزار  بسیار مهم است زیرا ترتیبی که نرم

 .برای مثال وضعیت زیر را در نظر بگیرید. شود تعیین می گونه نیاگیرد  می

ها را در هستند و آن My First Assignmentها دارای نام شما سه پروژه دارید که همه آنفرض کنید که 

 \C:\ Users\ Project-Filesو  C:\OP-Models ،C:\ Users\ OP-Modelsبه صورت  مسیرهای مختلف

OP-Models ها در ویژگی  فرض کنید که این پوشه. اید ذخیره کردهMod-Dirs اند به ترتیب زیر لیست شده: 
C: \Users\ OP-Models 

C: \ OP-Models 

C: \Users\ Project-Files\ OP-Models 

 

 \C: \Users کنید، فایل پروژه در پوشه  را باز می My First Assignmentبنابراین هنگامی که شما پروژه 

OP-Models افزار  به وسیله نرمOPNET های حاوی فایل پروژه  شود، زیرا این پوشه قبل از دیگر پوشه باز می
My First Assignment های پروژه واقع در پوشه  اگر شما بخواهید فایل. شود جستجو میC: \ OP-Models 

های پروژه  های شامل فایل در بالای دیگر پوشه Mod-Dirsنیاز به قرار دادن این پوشه در ویژگی را باز کنید 
My First Assignment توانید از  جایگزین، شما می به صورت. داریدGeneral File Chooser  برای باز

ها را به صورت  مدلهای پروژه و  به طور کلی، این ایده خوبی است که فایل. ها استفاده کنید کردن فایل
ها یا اجرای   های پروژه و دیگر مدل چنین سیاستی شما را از رونویسی تصادفی فایل. گذاری کنیم مختلف نام
 .دارد سازی با مدل نادرست، باز می یک شبیه

 ها و سناریوها پروژه . 1 – 5
IT GURU  وModeler  طیف وسیعی از مختلف شبکه در  یها یآور فنبه شمار اجازه انجام محالعه

یک . دهد یک پروژه انجام می به صورتسازی را  محالعه شبیه OPNET.دهند سازی را می های شبیه محیط
ای از محالعات  مجموعه به صورتتوانیم یک پروژه را  ما می. شود پروژه به یک یا چند سناریو تقسیم می

ی از تنظیمات پیکربندی مختلف ا آوری تحت محدوده و یا فن به خصوصسازی شده از یک سیستم  شبیه
 .تعریف کنیم

ای از مقادیر  یعنی مجموعه)سازی از یک سیستم و تحت یک تنظیم پیکربندی  سناریو یک محالعه شبیه
خواهد برای مشخ  کردن چگونگی  مثالی را در نظر بگیرید که یک شرکت می. است( پارامترهای پیکربندی

تواند یک پروژه به نام  برای این محالعه، شرکت می. ازی انجام دهدس توسعه شبکه زیرساخت خود محالعه شبیه
Network Expansion 10های  یوهای مستقل با نامرایجاد کند که به سناNodes-200K  ،20Nodes-200K، 

10Nodes-500K  20وNodes-500K های توصیفی برای پروژه و  به طور کلی انتخاب نام. تقسیم شده است
 .خوب استسناریو یک ایده 

های اضافه شده در زیرساخت شرکت را دارد، در  در مثال ما، اولین کلمه نام سناریو اشاره به تعداد گره
دهند را نشان  های جدید را به بقیه شبکه انجام می هایی که اتصال گره حالیکه کلمه دوم اشاره به ظرفیت لینک

 .دهد می



 

  

: ها و سناریوها، شامل موارد زیر است ریت پروژههای آسان برای مدی حاوی قابلیت OPNETمحصولات 
ها و سناریوهای جدید، تکرار سناریوهای موجود، سويیچ کردن از یک سناریو به سناریوهای دیگر،  ایجاد پروژه

های سناریوها و  سازی سازی برای یک سناریو یا چندین سناریو و مقایسه نتایج شبیه پیکربندی و اجرای شبیه
 .دهیم های بعد شرح می ها را در ادامه و بقیه را در فصل ما برخی از این قابلیت. فهای مختل پروژه

 ها کار کردن با پروژه . 1 -6
با باز کردن یک فایل پروژه موجود و یا ایجاد  OPNETسازی شده در  به طور معمول یک محالعه شبیه

 .شود یک پروژه جدید آغاز می

 باز کردن یک پروژه موجود. 1- 6 – 1
حالت ترجی  . را بزنید Ctrl-Oرا انتخاب و یا  OPNET ،File > Openبرای باز کردن یک پروژه موجود 

 Filesشونده ز سپس محمئن شوید که لیست با(. 3- 0 – 3بخش )انتخاب کنید  ها لیفاداده شده را برای مرور 

Of Type پروژه  یها لیفا(Project Files) را انتخاب کرده است. 
و یا یک بار کلیک و کلیک بر )خواهید باز کنید دو بار کلیک کنید  ای که می ی فایل پروژهحال بر رو
 .نظرتان داشته باشیدد های موجود برای یافتن پروژه مور شما ممکن است نیاز به مرور پوشه(. OKروی دکمه 

 Startup wizardایجاد یک پروژه جدید با  . 1 - 6 – 2

در زیر . کند فراهم می Startup Wizardقابلیت مفیدی به نام  OPNETبرای ایجاد یک پروژه جدید، 

 :آمده است Startup Wizardمراحل یک پروژه جدید با استفاده از 

را از لیست کشویی انتخاب کنید و  Projectرا انتخاب کنید، سپس  OPNET ،File > Newاز پنجره اصلی  

 .کلیک کنید OKسپس روی 

 (.را ببینید 3  -9شکل )تان را وارد کنید ی دلخواهنام پروژه و نام سناریو 

انتخاب شده  Use Startup Wizard When Creating New Scenariosمحمئن شوید که جعبه متن  

 .کلیک کنید OKروی . است

انتخاب شده باشد،  Startup Wizardاگر . دهیم را شرح می Startup Wizardحال ما اجزای کلیدی 

فرض خالی ایجاد  صورت یک پروژه پیشن در غیر ای. شود ظاهر می Initial Topology Windowپنجره 

 .سازی را توسعه بدهید توانید محالعه شبیه شود و شما می می

 Nextرا انتخاب کنید و روی  Initial Topology Window ،Choose Create Empty Scenarioدر  

 .کلیک کنید

، World ،Enterprise ،Campus ،Officeهای  ز گزینهیکی ا Choose Network Scale Windowدر  

Logical  و یاChoose From Maps  را انتخاب و رویNext کلیک کنید. 



 

 

اجاازه   Choose From Mapsهاای  گزیناه .شاود بساتگی باه انتخااب شاما دارد      هایی که بعد ظاهر می پنجره
دهاد، در حاالی    را می Choose Mapره تعریف یک مقیاس جغرافیایی بر اساس نقشه انتخاب شده از طریق پنج

سازی شده توسط طول و  اجازه مشخ  کردن ابعاد ناحیه شبیه Officeو  Enterprise ،Campusهای  که گزینه
 .دهند می Specify Sizeعرض یک ناحیه مستحیل را از طریق پنجره 

 Map Infoهاای   قشاه و یاا در باین ن   Border Mapای را در  گزینه( 3 -9شکل ) Choose Mapدر پنجره  
وقتای  . نظار کلیاک کنیاد    برای انتقال نقشه انتخاب شده به ناحیه ماورد  <<موجود انتخاب کنید و سپس دکمه 

 .را برای انجام گزینه بعدی پیکربندی کلیک کنید Nextهای جغرافیایی انتخاب شد   نقشه
 .کلیک کنید Nextرا در شبکه مشخ  کنید و روی  yو  xاندازه  Specify Sizeدر پنجره  
 هاااای پنجاااره Startup Wizard ساااازی شاااده مشاااخ  شاااد،   هنگاااامی کاااه ابعااااد ناحیاااه شااابیه   

Select Technologies  وReview کند را باز می. 

 ?Includeهای مدل مورد استفاده را به وسیله کلیک جعبه زیر  ، خانوادهSelect Technologiesدر پنجره  
ای منساجم از   یک خانواده مادل مجموعاه  . را کلیک کنید Nextدکمه  انتخاب و Yesبه  Noبرای تغییر آن از 

 .و غیره است Internet- Toolbox  ،MANET, Ethernet، Cisco: از قبیل ها یآور فن

ها قسمتی از خانواده  کنید، اشیاء در آن خانواده هنگامی که شما یک یا چند خانواده مدل را انتخاب می
 .شوند ظاهر می Object Paletteنگام باز شدن فرض خواهند بود که ه مدل پیش
( ای را انتخاب نکنید آوری یا حتی وقتی شما هیچ فن)نظر د های مور آوری نظر از انتخاب فن صرف

 .موجود است Object Paletteفرض همواره در ها و نه خانواده مدل پیش آوری مجموعه کلی اشیاء در همه فن
 .کنید کلیک Finishروی  Reviewدر پنجره  

 
 ایجاد یک مدل جدید 1 -8شکل 

 

 choose mapپنجره  1 -9شکل 



 

  

در هر زمان برای برگشت به پنجره قبلی  Backتوانید از دکمه  شما می Startup Wizardهنگام استفاده از  
و ایجاد یک پروژه  Startup Wizardبرای خروج از  Quitتوانید روی دکمه  شما همچنین می. استفاده کنید

 .فرض، کلیک کنید پیش

 حذف یک پروژه . 1- 6 – 3
نیاز به  ها آنممکن است چندین پروژه ایجاد کند که برخی از  OPNETگاهی اوقات یک کاربر تازه کار 

 .های مرتبط با یک پروژه به خصوص، حذف دايم خواهند شد با انجام مراحل زیر همه فایل. حذف شدن دارند
شود که  با این کار یک پنجره باز می. را انتخاب کنید OPNET ،File > Delete Projectsاز پنجره اصلی  

 .های قابل دسترس است شامل لیستی از همه پروژه
که پس از آن ظاهر  Confirmدر پنجره  OKبرای حذف یک پروژه، ابتدا بر روی آن و سپس بر دکمه  
 .شود يمی میهای پروژه از دیسک حذف دا با این کار همه فایل. ود کلیک کنیدش می

 .های غیرضروری و اضافی تکرار نمایید در صورت نیاز، این روال را برای حذف همه پروژه 
 Delete جهت بستن پنجره  Closeنظر حذف گردید، بر روی دکمه د های مور هنگامی که همه پروژه 

Projects کلیک کنید. 

 کار کردن با سناریوها .1- 7
های خاص و یا  های کوچک که بررسی جنبه گ به قسمتسازی بزر یهبه سازماندهی محالعات شبسناریوها 
خواهید  سناریوها همچنان هنگامی که شما می. کنند دهند، کمک می نظر را انجام مید های مور پیکربندی پدیده
 نرخ داده یک لینک، تعداد: از قبیل تغییر. سازی را با چند پیکربندی مختلف تکرار کنید، مفید هستند یک شبیه
در این موارد . آوری بکار رفته و غیره ، فنTCP، پروتکل مسیریابی، قابلیت LANهای کاری در یک  ایستگاه
توانید چندین سناریو در داخل یک پروژه برای سازماندهی بهتر محالعه و تسهیل مقایسه چند پیکربندی  شما می

 .از شبکه مورد محالعه، داشته باشید
OPNET در واقع . کند ای انجام دادن سناریوهای پروژه را فراهم میهای متعددی بر قابلیتProject 

Editor شود، شامل یک منوی کشویی  سازی ایجاد و پیکربندی می ای است که در آن محالعه شبیه پنجره
های مختلف برای مدیریت سناریوهای پروژه دارد  است که اختصاص به گزینه Scenariosجداگانه با نام 

 (.ا ببینیدر 3 -32شکل )
های اضافی  گزینه. دهد های مورد استفاده در منوی سناریو را توضی  می ترین گزینه بخش جاری معمول زیر

های مختلف در خصوص سناریوی کنونی که شرح آن داده  برای تولید، پیکربندی، دسترسی و مقایسه گزارش
 .نشده، وجود دارد

 ایجاد سناریوها .1 – 7 – 1
 :های جایگزینی برای ایجاد سناریوها است روش Scenariosی دو گزینه اول منو



 

 

 (Ctrl + Shift + N) New Scenario این گزینه از . کند یک سناریوی خالی در پروژه جاری ایجاد می
های قبل برای ایجاد یک سناریوی خالی با استفاده از  روال یکسانی برای ایجاد یک سناریو که در بخش

Startup Wizard   کند داده شده بود، استفاده میتوضی. 

 
 برای مدیریت سناریوهای پروژه Project Editorهای  گزینه 1 -11شکل 

 (Ctrl + Shift + D) Duplicate Scenario :این گزینه سناریوی . کند سناریوی جاری را تکرار می
مفید است که این گزینه به خصوص هنگامی . کند دیگری که با سناریوی جاری یکسان است ایجاد می

در چنین . کند محالعه یک مدل اساساً از همان تنظیم به جزء چند تفاوت کوچک در پیکربندی استفاده می
مواردی، شما نیاز به تکرار سناریوی موجود و سپس تغییر تنها چند پارامتر پیکربندی که متفاوت هستند 

 .دارید

 مدیریت سناریوها .1- 7 – 2
است که یک ابزار جامع برای مدیریت  Scenario  ،Manage Scenariosگزینه بعدی در منوی 
سازی پیچیده و بزرگ که شامل سناریوهای  هنگامی که یک محالعه شبیه. سناریوهای پروژه جاری است
سازی و شروع اجرای همه سناریوهای  که پیکربندی شبیهاست تر این  شود روش عملی متعددی است، انجام می

. جا و تنها با یک کلیک انجام شود یک به صورتبندی و اجرای سناریوهای مستقل، نظر بجای پیکرد مور
به همه سناریوهای پروژه را  Manage Scenariosنشان داده شده است، پنجره  3. 33که در شکل  یطور همان
 :کند های زیر سازماندهی می جدولی با ستون صورت

توانید از  به همراه شماره سناریو می Ctrlمه با فشردن دک. کننده شماره سناریو است مشخ  :‌# 
Project Editor ای از  کلیک چپ بر روی شماره سناریو مجموعه. نظر سويیچ کنیدد به سناریوی مور

 .کند ها را برای حرکت از سناریوی انتخاب شده به محل مختلفی از جدول فراهم می گزینه
 Scenario Name: ک چپ بر روی نام سناریو اجازه تغییر نام آن کلی. کند نام سناریو را مشخ  می

 .دهد سناریو را می



 

  

 
 unsaved manage Scenariosهای  گزینه 1 -11شکل 

 Saved: تواند  کند که می وضعیت سناریوی جاری را مشخ  میSaved  یاUn Saved با کلیک بر . باشد
که وقتی انتخاب شود سناریوی جاری  شود باز می <Delete>ای به نام  یک سناریو، گزینه Savedروی سلول 

 .شود می یگذار نشانهبرای عمل حذف 

 Results :گردد کند که به وسیله یکی از مقادیر زیر تعیین می سازی را مشخ  می وضعیت نتایج شبیه: 
 Unallocated :آوری نشده است ای برای این سناریو جمع سازی که هیچ نتایج شبیه. 
 Out Of Date :تغییرات ممکن در پیکربندی  لیبه دلازی برای این سناریو موجود است اما س نتایج شبیه

 .قابل استفاده نیست
 Up To Date :است به روزسازی برای این سناریو موجود و  نتایج شبیه. 
 :شود های زیر فراهم می از یک سناریو گزینه Resultsبا کلیک بر سلول  
 < Collect > : این . کند آوری مجدد نتایج پیکربندی می جاری و جمعپروژه را برای اجرای سناریوی

 .باشد Results ،Up To Dateگزینه تنها زمانی موجود است که مقدار سلول 
 <Discards> :این گزینه تنها زمانی . کند پروژه را برای رها کردن نتایج سناریوی جاری پیکربندی می

هنگامی  به خصوصباشد و  Out Of Dateو یا  Up To Dateسازی  برای سناریو موجود است که نتایج شبیه
سازی گاهی نیازمند  جویی در فضای دیسک دارید، از آنجايیکه نتایج شبیه مفید است که شما نیاز به صرفه
 .فضای زیادی از دیسک است

 Sim_Duration :توانید با کلیک  شما می. کند سازی را مشخ  می طول زمان اجرای یک سناریوی شبیه
 (مثلاً مقدار جدیدی در سلول وارد کنید)سازی را تغییر دهید  سلول زمان شبیهدر این 

 Time Units : واحدهای مقدار مشخ  شده در سلولSim-Duration کلیک در این . کند را مشخ  می
 :دهد سلول در یک سناریو به شما اجازه انتخاب واحدهای زمانی زیر را می

Second(s)،Minute(s) ،Hour(s) ،Day(s)  و یاWeek(s). 



 

 

 Collectو یا  Delete ،Discard Resultsهای  توانید از دکمه اگر یکی از سناریوها انتخاب شود، می

Result آوری مجدد نتایج،  برای سناریوی انتخاب شده، به ترتیب برای حذف کارها کردن نتایج و یا جمع
 .گذاری کنید نشانه

 :وجود دارد  Manage Scenariosهمچنین چندین گزینه اضافی در ابزار 
را فراهم  < Delete All >گزینه  Savedو  Scenario Name ،#های کلیک بر روی عنوان ستون 
که عمل قبلی  <Keep All >کند و گزینه گذاری می کند که همه سناریوهای پروژه را برای حذف نشانه می

 .گرداند را برمی

کند که همه سناریوهای  را فراهم می < Collect All >گزینه  Resultsکلیک بر روی عنوان ستون  
 نظر صرفکه همه سناریوهای پروژه را برای  < Discard All >کند و  گذاری می پروژه را برای اجرا نشانه
 .کند می یگذار نشانهسازی  کردن از نتایج شبیه

ها را برای  های از گزین مجموعه Scenario Nameو یا  #کلیک بر روی یک سلول خالی در ستون  

 .کند جدید فراهم می یتکرار یک سناریوی موجود و یا ایجاد یک سناریو

توانید با دکمه  اید، می دلخواهتان پیکربندی کرده به صورتدر نهایت هنگامی که شما سناریوهای پروژه را 

OK  همه تغییرت را ذخیره و یا با دکمهCancel  از پنجرهManage Scenarios زی تغییرات سا بدون ذخیره

و یا  Collectگذاری شده برای  کنید همه سناریوهای نشانه کلیک می OKهنگامی که روی دکمه . خارج شوید

Recollect این قابلیت بسیار . کنند سازی، به ترتیب شماره سناریو به صورت خودکار شروع به اجرا می شبیه

 .دهد وس میمفیدی است که اجازه اجرای چندین سناریو را با یک کلیک ما

 انتخاب یک سناریو.  1 –7–3

 :، انتخاب کردن یک سناریو در پروژه جاری استScenariosهای منوی  مجموعه بعدی گزینه
 (Ctrl + Up) Previous Scenarios  این گزینه در صورتی که .کند قبلی لیست سويیچ می یویسناربه

 .دهد روی اولین سناریو باشیم کاری انجام نمی
 (Ctrl + Down) Next Scenarios اگر در آخرین سناریو باشیم، .کند به سناریوی بعدی لیست سويیچ می

 .دهد این گزینه کاری انجام نمی
 Switch To Scenario  دهد در پروژه جاری را می به خصوصاجازه سويیچ به یک سناریوی. 

 وارد کردن اجزاء سناریو .1 -7 -4
و یا  (Import)است که اجازه وارد کردن Scenarios ، Scenario Componentsگزینه دیگری در منوی 

سازی و  اجزاء مختلف سناریوی جاری شامل مدل شبکه، مدل آماری، نتایج شبیه (Export)صادر کردن 

ذخیره  OP-Modelsفرض اجزاء سناریو صادر شده در پوشه  به طور پیش. دهد اطلاعات پیکربندی را می

عمل وارد . دسترسی دارد OPNETای از  ردن اجزاء به هر پوشه قابل مشاهدههر چند، عمل وارد ک. شوند می



 

  

کند، مگر اینکه اجزاء خودشان یک سناریو باشند که در این  کردن، اجزاء سناریوی موجود را بازنویسی می

برای اضافه کردن یک سناریو مراحل زیر را دنبال کنید . شوند به پروژه جاری اضافه می( ها)حالت سناریو

 (:را ببینید 3 -30شکل )

 Scenarios > Scenario Components > Import را انتخاب کنید. 

 .انتخاب کنید Importرا از لیست کشویی در بالای پنجره  Projectنوع اجزاء  

 .پروژه مورد نظرتان را انتخاب کنید 

را  < All Scenarios >نظر و یاد ، سناریوی مورImportاز لیست کشویی گوشه چپ پایین پنجره  

 .کلیک کنید OKانتخاب و روی دکمه 

تواند مقادیر مختلف را از لیست  خواهید اجزاء نوع دیگری از پروژه را وارد کنید، می در روال فوق اگر می

تنها زمانی موجود  Importپنجره ( سمت چپ)لیست کشویی پایین . انتخاب کنید Importکشویی بالای پنجره 

 .کنید است که شما اجزاء سناریو از نوع پروژه را وارد می

 
 وارد کردن اجزاء سناریو از نوع پروژه 1 -12شکل 



 

 

 

 فصل

2 
 ایجاد همبندی شبکه

 

 مقدمه. 1-2
های ارتباطی یا خحاوط ارتبااطی را کاه در یاک     ها و کانال ای یا گرههمبندی شبکه ارتباط تجهیزات شبکه

 .دهد یمرا نمایش  اند گرفتهمحیط فیزیکی در کنار هم قرار 

همبنادی فیزیکای طارح واقعای     . دنشاو  یما کی و منحقی شبکه فرق قايال  در ادبیات اغلب بین همبندی فیزی

در این طارح نحاوه قرارگیاری فیزیکای و فاصاله واقعای        ،باشد یم ها آنو نحوه ارتباطات بین  ها گرهقرارگیری 

تک یا منحقی یک نمایش مجارد از مسایر ارتبااطی باین      یهمبنداز طرف دیگر . شود یمارتباطی در نظر گرفته 

همبنادی منحقای اغلاب باا پیکربنادی      . باشاد  یما بدون در نظر گرفتن موقعیت فیزیکی و مساافت واقعای    ها گره

بکاار   هاا  دادهارتباطی ارسال و دریافت  یها کانالهمبندی شبکه و تجهیزات آن بوده و به منظور نمایش منحقی 

  .رود یم

  شاده نحقی شبکه شبیه ساازی  جهت ایجاد همبندی فیزیکی و م OPNETو امکانات  ها یژگیواین فصل به 

 :نمایش داده شده است، وجود دارد 0-3همبندی اصلی که در شکل  2 اساساً. پردازد یم

 ها گرهتمام  Fully-Connected Meshدر شبکه 

. هساتند  دیگر متصال  یها گرهمستقیم به تمام  به طور

باه   هاا  گرهتمام  لزوماً  Partially-Connectedاما در 

 Busدر همبنادی   .دیگر متصال نیساتند   یها گرهتمام 

شابکه   یهاا  گرهتمام  Busیک زیرساخت واحد بنام 

و هایچ گاره    کند یمرا به هم متصل  ها گرهیک گره مرکزی، تمام  Starو در همبندی . دینما یمرا به هم متصل 

هر گره به دو گره مجاور خود متصل شاده    Ringمستقیم به هم متصل نیستند و در همبندی  طور به یمرکز ریغ

هیچ دو گره ای از طریق یاک مسایر واحاد  باه      Tree همبندی درختی . دهند یم  حلقهکه تشکیل یک  طوریه ب

 . باشد یمترکیبی از چند همبندی فوق  Hybridهم متصل نیستند و در آخر همبندی 

 ،ده یک مسیر واحد دارند فرق قايل شا ک ییها گرهدارند و ( واسط) که چندین مسیر  ییها گرهبین  نتوا یم

مشابه مسئول برقراری ارتبااط   یا شبکهها و سایر تجهیزات  Gateway/Routerها،  Switch ،ها Hubبرای مثال 

و هار گاره    باشند یم( Multiple Path )در شبکه بوده و بنابراین دارای چند مسیر ارتباطی  ها گرهبا سایر  ها گره

باه ایان تجهیازات ،     باشاند  یما از طریق یک مسیر واحاد باه شابکه متصال     ... کاری،  یها ستگاهیانظیر سرورها، 

Fully-connected Mesh 
Partially-connected Mesh 

Bus 
Star 

Ring 
Tree 

HybrId 

 



 

  

 باه صاورت  انتهاایی   یهاا  گاره البتاه شااید در برخای شارایط      شاود  یما اطالاق  ( End Node)تجهیازات نهاایی   

Multihome جهت افازایش قابلیات    مثلاًند و دارای چند مسیر ارتباط باشند باشند یعنی به چند شبکه متصل شو

باه   افازون چنادین مسایر    تواناد  یما ارتجاعی و انعحاف پذیری و اعتماد در زمان خرابی ارتباطات یک شارکت  

 .به شبکه مهیا سازدرا  سرورهایش

OPNET  مهیاا   تاان  یابار ای ابار شابکه  ، ارتبااطی،   یا شابکه تجهیازات   یهاا  مادل یک کتابخانه بزرگی از

ارتبااطی   یهاا  واساط با هم متفاوت باوده و از  ...(  هاب، سويیچ  -سرور) شان عبر اساس نو ها مدلاین . سازد یم

 :به موارد زیر اشاره کرد توان یم ها مدلاز جمله این . کنند یممختلفی پشتیبانی 

و کاار باا    پاردازد  یما  یا شابکه جهات ایجااد همبنادی     OPNETاین فصل به امکانات مختلف موجاود در  

را داده و یک  ها شبکه ریزو  ها آنپرداخته و چگونگی کار با  Rapid Configurationو  ‌Object Paletteابزارهای

 .دهد یمشمای کلی از ابزارها را ارايه 

Full mesh

Partially Mesh Bus
Star

Ring

Tree

Hybrid

 انواع توپولوژی یا همبندی شبکه 2-1شکل 

Ethernet  Server 
Point to – point protocol (ppp) 

Workstation 
IP router with Ethernet And ppp interface 

100 Base- T Lan 
Ethernet / Fiber Distributed Data Interface ( FDDI) Switch  

100Base-T Ethernet Link 
56 kbps ppp Link , … 

 



 

 

 
 Object Palette Treeنماي پيش فرض   2-2شكل 

 براي ایجاد همبندي شبكه Object Paletteابزار درخت  . 2 – 2
 دیا توان یما از طریق این ابازار، شاما   . دینما یممهیا  تان یبرارا  OPNETی ها مدلاین ابزار دسترسی به تمام 

 مادل کنید و حتای یاک   مدیریت  مکرراًاستفاده شده را ی ها مدلنموده و ایجاد شبکه دلخواه خود را توپولوژی 

کاه باه    Object Paletteیک نمای کلای از ایان ابازار را باه هماراه مجموعاه        0-0کل ش. دیینماسفارشی تولید 

Internet-Toolbox  دهد یمتنظیم شده نشان. 

 Startupباا کماک   جدیاد   Objectشاما یاک    کاه  یزماان اتوماتیاک   به طور Palette Objectدرخت پنجره 

Wizard  ( 3-9-0بخش ) آن را از درون  دیا انتو یما همچناین  . شاود  یم، باز دیکن یمایجادProject Editor    یاا باا

از مناوی   Object Palette  > Topology انتخااب یاا باا   جعباه ابازار   در  Open Object Paletteکلیک روی آیکون 

 .دیینماکشويی باز 

را جستجو و یا از ابزارهاای جساتجوی موجاود در آن جهات یاافتن       Open Object Palette دیتوان یمشما 

باا کشایدن باه     دیتوان یمیک مدل پیدا شد،  که یزمان. دیینمارهای ارتباطی مورد نیاز خود پیمایش و مسی ها گره

 .مورد استفاده قرار دهید Editor Projectمحیط کاری 

Object Palette Tree  گردد یمبه چند دسته تقسیم: 

 Node Models Palette‌ ارتباااطی نظیاار  یهااا گاارهشااامل اغلاابSwitch ،Hub ،Router، Gateway ،

Server ،Workstation  ...باشد یم. 

 Link Models Palette   1000شامل اغلب مسیرهای ارتباطی نظیارBase-T Link  ،T1 ،16 Mbps Token 

Ring  باشد یم... و. 

 Path Models Palette  همانند  یا شبکهشامل اغلب مسیرهایHAIPE ،MPLS ،PSTN  باشد یم.... و. 



 

  

 Demand Models Palette        شاامل اغلاب جریاان ترافیکای خااص نظیارVoip ،PSIN Voice Traffic ،IP 

Security  باشد یم... و. 

 Wireless Domain Models Palette  بی سیم نظیر  یها حوزهاز  یا مجموعهشاملFull Grid ،Sparse 

Grid ،Mobility باشد یم. 

 Shared Object Palette   کاه بار اسااس    ... ، هاا  حاوزه ت، مسایرها،  هاا، ارتباطاا   از گاره  یا مجموعاه شاامل

 .باشد یم 3Com، شامل تجهیزات تولید شده شرکت 3Comبرای مثال مجموعه  یها یژگیو

 Application Palette  : باشد یمکاربردی  یها برنامهمورد نیاز جهت توسعه  یها مدلاین جعبه نیز شامل. 

 .لازم جهت مدل سازی اینترنت است یها مدلفوق و  یها بخشنیز شامل تمام  Internet-Toolboxگروه 

 مدل کنوانسیو  نام گذاری. 2 – 2 – 1
که توسط نام نوع ماشاین،   شود یمبه چندین زیرگروه تقسیم  Object Palette Treeدر  ها مدلهر گروه از 

Object Idشود یمارتباطی و سایر پارامترها تقسیم بندی  ، نام سازنده ، نوع واسط، مدل. 

. قابل دسترسی هساتند  Paletteاز چندین  ها مدلبه این معنی که برخی  افتند یماغلب روی هم  ها روهگاین 

قابال   یهاا  واساط ( Lanسارور، دروازه،  ) شامل اطلاعاتی در خصوص ناوع ارتبااط و گاره     معمولاًنام هر مدل 

 .باشد یمنوع از هر  ها واسط یو تعداد( ATM ،SLIP  ،FDDI ،Token Ring ،Ethernet) دسترسی 

و جعبه پیش فرض یاا   Internet-Toolboxقابل دسترس در جعبه  یها مدلیک لیست جزيی از  0-1شکل 

-CSناام انتخااب شاده    . دهاد  یما در حین ایجاد پاروژه را نشاان    Startup Wizardخانواده انتخاب شده توسط 

4000-3S-E6-Fr2-Sl2-Tr2 باشد یم. 

ناام مادل شاامل     .باشد یمکه یک گره ثابت است  Cisco S4000نشانگر مدل مسیریاب  ،بخش نخست نام

 :شود یمزیر  یها بخش

CS –  شرکتCisco FR2 – دو واسطFrame Relay 
40vo –  نوع مسیریابCisco Sl2 –  دو واسطSLIP  

3S –  سهSlot TR2 –  دو واسطToken Ring 

E6 – 9 واسط اترنت دار  
 Ether Channel، 9واساط   9اترنات و   9یااک ساويیچ دارای   Eth6-Ethch6-Fdd6-Tr6مشاابه   باه طاور  
کاه   باشد یم IPیک دروازه  Ethernet 4- Slip  8- Gtwyو  باشد یم Token Ring واسط 9، و FDDI واسط
ارای یک واساط  نیز یک سرویس گیرنده د Ethernet_Wkstnو  باشد یم  IPواسط  9واسط اترنت و  0دارای 

 .باشد یم  SLIPنیز یک ارتباط نقحه به نقحه با واسط  ppp-Serverاترنت  است و 

نام مادل اطلاعاات کاافی در خصاوص     . باشد یم ها گرهارتباطی بسیار شبیه  یها مدلکنوانسیون نام گذاری 

نشانگر این اسات  ( Description)که توضیحات مدل  در حالی سازد یمپروتکل ارتباطی و ظرفیت ارتباط مهیا 

  .است Duplexیا  Simpleنوع که آیا  ارتباط از 



 

 

 باشد یماترنت    1000Base-Xیک مدل از لینک   1000Base-Xکه  دهد یمنشان  0-1برای مثال، شکل 
 Duplexاز نوع  28Kpbsنیز یک مدل از ارتباط  ppp-28Kو  DS1یا  T1با ظرفیت  FRیک لینک  FR-T1و 

 .کند یمپشتیبانی   SLIPکه از است نقحه به نقحه 
، Busجهت ایجاد یک توپولوژی . باشند یمارتباطی ساده و اندکی  یها مدلبه  مند، نیازBus  یها یوژتوپول
 Busارتبااطی   یهاا  مدلزیر  Object Palette Treeدارید که در جعبه  Busو  Bus Tup یها مدلشما نیاز به 

Models  وLink Models Tup  اند گرفتهبه ترتیب دسته بندی قرار . 
OPNET برای مثال. سازد یمکامل را مهیا  یها شبکه یها مدلنین برخی همچ: 
اترنات باه هام     10Base-Tاز طریاق ارتباطاات    ها گرهکه در آن  باشد یم Lanیک  10Base T-Lanمدل 
-IP32مادل   .دهاد  یما را نشاان   ATMواساط   32باا   ATMیک شبکه  Atm32-Cloudمدل  .شوند یممتصل 

Clould  یک شبکهIP  واسط  10باSLIP   جهت شبیه ساازی اینترنات بکاار     معمولاًاین مدل . شود یمرا شامل
 .رود یم

،  Application Config  ،IP VPN Config ،IP Attribute Configابازاری نظیار    یهاا  گاره در آخار،  
Profile Config  بلکه توسط  دهند ینمو سایرین هیچ وسیله واقعی خاصی را نمایشOPNET   جهت نصاب و

 .روند یمبکار  یا شبکه یها یتکنولوژکاربردی مختلف و  یها برنامه پیکربندی

 

 Internet- Toolbox یها گروه ریزدر جعبه  ها مدلبرخی از  2-3شکل 

  Internet- Toolboxها در جعبه   مدل .2-2-2
باه  ول معم یها یتکنولوژو  یا شبکه یها پروتکلموجود در این جعبه ابزار اغلب جهت کار برای  یها مدل
نشاان   هاا  مادل از اساتفاده معماول از برخای از ایان      ایشارح خلاصاه  لیست  زیر . باشند یمابزارهای لازم  همراه
 :دهد یم



 

  

 ppp-wkstnو‌‌ethernet-wkstn‌‌:کاه   یینهاهای های کاری کاربر و گرهجهت مدل سازی ایستگاه
 .روند یمسازند بکار مهیا می Ethernet و  SLIPهای کاربردی را بر روی ارتباطات انواع مختلفی از برنامه

 ethernet-serverو‌‌‌ppp-server‌:‌    بکاار   ییانتهاا  یهاا  گاره جهت مدل ساازی سارورها و همچناین
و اترنت   SLIPرا بر روی ارتباطات  ها رندهیگبرای کاربردهای مختلف سرویس  ییها سیسروالبته  روند یم
 .دهند یمرا  Client-Serverاجازه مدل کردن نمونه  یها گاهستیادر ضمن اشیاء  سرور  و . سازند یممهیا 

 1000Base-X-Lan:    یهااا شاابکهجهاات ماادل سااازی LAN    1000اترناات کااه ارتباطاااتBase-X  ،

100Baset-L-Lan ،10Baset-Lan  هار کادام از   باا  پایش فارض    باه طاور  . رود یما بکاار   شوند یمرا شامل

 .شبیه سازی شوند تواند یم ییانتهاگره  32با  LAN یها شبکهبالا  یها مدل

 ethernet 32-Hub‌:‌ جهت مدل سازی تجهیزاتHub       گاره   10اترنات و تکرارکنناده  لایاه یاک تاا

 .رود یماترنت تک بکار  یا شبکهاترنت جهت ایجاد یک سگمنت  ییانتها

 ethernet16-switch‌‌:    واساط بکاار    39جهت مدل سازی یک سويیچ اترنت و تجهیازات لایاه دو باا

 .رود یم

 ethernet4-SLIP 8-Gtwy‌:‌ با  باشد یم 1جهت مدل سازی یک مسیریاب دروازه که یک وسیله لایه

 .رود یمبکار   SLIPواسط  9واسط اترنت و  0

بکاار   هاا  چیساوي هاا یاا    LAN ،Hubهای محلی نظیر اشیاء  شبکه ریزجهت ارتباط  عموماًاترنت  یها واسط

مسایریاب   یها گره به عنوان IP یها شبکهجهت مدل سازی ارتباطات  ماًعمو IP یها واسطدر حالیکه . روند یم

 .روند یمکاری بکار  یها ستگاهیاو سرورها و 

 Ethernet2-SLIP 8-Firewall‌:    اماا باه هماراه     رود یما جهت مدل سازی یک مسایریاب دروازه بکاار

 .دباش یم  SLIPواسط  9اترنت و  0این مدل دارای . ویژگی اضافی دیواره آتش

 IP32-Could‌:  جهت مدل سازی یک ابرIP   ایان مادل دارای   . رود یما و نمایش ارتباطات اترنت بکاار

 .باشد یمسریال  IPواسط  10

 1000Basex-Lan‌،100Base T‌‌،10Base T‌‌: اترنات   یها واسطجهت مدل سازی اشیاء ارتباطی که

 .رود یمبکار  کند یمرا به هم متصل 

 ppp-28K‌‌،ppp-33K‌،ppp-56K‌،ppp-DS1‌‌،ppp-DS3‌:  جهت مدل سازی ارتباطات نقحه به نقحه

Duplex  برقراری ارتباط دو نقحه  برایارتباطی مختلف  یها نرخباIP  روند یمبکار. 

 Application Config‌‌،Profile Config‌:   یهاا  لیا پروفاپیکربنادی کاربردهاا و    یمادل سااز  جهات 
و  ۳در فصال   ها مدلما اطلاعات بیشتری در خصوص این . روند یمکاربر در محیط شبیه سازی شبکه بکار 

 .میا آورده 2



 

 

  Object Paletteكار با درخت  .3-2
ارتباطی مورد نیاز جهت شبیه  یها مدلو یافتن وسایل و  Object Palette Treeاین بخش دستورات کار با 

 .سازی و ایجاد توپولوژی شبکه را مهیا کرده است

  Object Paletteباز کرد   .1-3-2
از یکاای از دو روش زیاار اسااتفاده  Project Editorاز درون  Object Palette Treeجهاات باااز کااردن 

 :گردد یم
 .کلیک کنید Object Paletteروی شکل  :1روش‌
‌.را از منوی کشويی انتخاب کنید‌Open Object Palette‌Topology <:‌8روش‌

 Object Paletteدر  ها مدلجستجو برای  .2-3-2
Object Palette Tree  بارای مثاال   . دیا نما یما مهیاا  بر اساس ناام آن هاا    ها مدلامکان جستجو جهت یافتن

در جعباه ماتن روبارویش تایاپ      Search By Nameرا در بخاش   Switchسويیچ، کلمه  یها مدلجهت یافتن 
اساس موقعیت فعلی در درخت  جستجو ابتدا  بر. بگردید ها چیسوي به دنبال Find Nextنموده و با کلیک دکمه 
) چنانچه مدل پیدا شود، آنگااه ابازار جساتجو آن را مشاخ      . ابدی یم  ادامهدرخت  نییپاانجام شده و به سمت 

Highlight )با زدن دکمه . دینما یمFind Next  چنانچه مدلی پیدا . شود یمیافت  ها مدلمدل بعدی در درخت
 .دلی مشخ  و روشن نخواهد شدنشود پنجره بدون تغییر مانده و هیچ م

: برای مثاال . باشند ینمشامل کلمه کامل که مشخ  کننده مشخصات مدل است  ها مدلتوجه کنید که نام 
اترنت ممکان   یها واسطدر اسمشان نیستند در حالیکه تجهیزاتی با  Linkارتباطی شامل کلمه  یها مدلخیلی از 

برای همین منظور شما بایستی یک شارایط  . باشند Ethernet در اسمشان بجای کلمه کامل ethاست فقط شامل 
وقتای در حاال   . دییا نماجهات یاافتن مادل ماورد نظرتاان ایجااد        Object Palette Treeجستجو و با توجه باه،  

هستید، اغلب نام اشیاء و خلاصه توضی  مدل جهت انتخااب مادل    Object Paletteجستجوی مدل موجود در 
) ، مدل را انتخاب نماوده  ها مدلدر خصوص  یتر کاملهد بود و جهت یافتن اطلاعات مورد نظرتان کافی نخوا
کلیک کنید و یا روی مدل کلیک راست نموده  Model Detailsو سپس بر روی دکمه ( روی آن کلیک کنید

 .دیینمارا از منوی کشو انتخاب  View Model Detailsو 

 سفارشی یها مدلایجاد  .3-3-2
شامل تجهیازات لازم و تعاداد و ترکیباات ماورد نیااز و       Object Paletteموجود در  یها مدلبعضی مواقع 

جهات  . دهاد  یمبه شما اجازه ایجاد یک مدل گره سفارش  OPNETبرای این حالات، . لازم نیستند یها واسط
 :انجام این کار مراحل زیر را دنبال کنید

 (دیده شود 0-1-3بخش . ) دیینمارا باز  Object Paletteپنجره  
همانند شاکل   Create Custom Deviceکلیک نموده تا پنجره  Create Custom Modelروی دکمه  
 .باز شود 0-0

 .دیینماانتخاب ...( اب، سويیچ، ابر ینظیر مسیر) جهت ایجاد مدل را نوع تجهیزات دلخواه  
 .باشد یم.. Switch  (ATM ،Ethernet ،FDDI . )گاهی نیاز به زیر انتخاب نظیر تعیین نوع  



 

  

را ... و  هاا  آنو تعاداد   هاا  واساط ایان مقاادیر ناوع و    . تجهیزات را معین کنیاد  یها یژگیوپارامترهای و  
 .باشد یمگاهی نیاز به تعریف اطلاعات دیگری نیز برای تجهیزات جدید . کنند یمتعیین  معمولاً

لیاک روی شاکل آیکاون آن    با ک. شکل آیکون نمایش وسیله را عوض کنید دیتوان یمدر صورت نیاز  
 .دهد یمباز شده که به شما اجازه انجام این کار را  Icon Platteپنجره 
جعباه   دیا توان یما اماا شاما    شود یمذخیره  My_Model_Listپیش فرض، وسیله جدید در جعبه  به طور 

 .جهت ذخیره انتخاب کنید Destinationدیگری را از لیست کشويی بنام 

ایجااد وسایله    OKمقصد ذخیره وسایله جدیاد را مشاخ  کردیاد، روی دکماه       و ها یژگیووقتی تمام  
 .دیینماجدید کلیک 

کناد کاه    باه شاما اعالان مای     OPNET. را انتخاب کنیاد  OKسرانجام، نام وسیله جدید را تایپ نموده و  
 باه طاور پایش فارض در    و  باز خواهد شاد  Object Palette Treeوسیله جدید با موفقیت ایجاد شده و در 

 .شود یمذخیره ( Op_Models معمولاً)  تان یمحل سکیهاردد

 
 .ایجاد تجهیزات سفارشیپنجره  2-4شکل 

 ایجاد توپولوژي شبكه .4-2
تجهیزات آماده و تعیاین گشاتند، شاما آمااده بارای ایجااد توپولاوژی         یها نکیلمورد نیاز و  یها گرهوقتی 

 0-0-0تاا   0-0-3بخاش  . خواهیاد باود   Object Paletteاز شبکه برای عمل شبیه سازی محالعه خود با استفاده 
لازم را بیاان   هاای و هر ویرایش یا شبکهو ارتباطات در توپولوژی  ها گرهدستورات برای حذف و اضافه نمودن 

 .دینما یم



 

 

 .(محالعه شود 0-1-3بخش . ) باشد یمباز  Object Paletteکه  کند یمفرض  ها بخش ریزتمام این 

 ها گرهتوپولوژی شبکه اضافه کرد   ایجاد .1-4-2
. روی آن انتخااب کنیاد   را با کلیک دیخواه یم  کهمدل گره  جستجو نموده و Object Palette Treeدر  

 .شود یمبرای مدل انتخابی ظاهر  Object Palette Treeیک آیکون در بخش سمت راست پنجره 

که شامل توضیحات کاملی از مدل اسات  یک پنجره جدید  دیینماکلیک  Model detailsبر روی دکمه  

 .تان خواهد کردمورد نظر و تجهیزات لازم شبیه سازیباز شده که کمک شایانی به تعیین درست شی 

کشایده و در محال    Projectجهت ایجاد گره جدید در توپولوژی شبکه آیکون مادل گاره را باه محایط      

در  انتا  Projectکلیک کرده و سپس بر روی محایط  بر روی آیکون مورد نظر  دیتوان یمیا . مناسب رها کنید

 .محل دلخواه کلیک کنید

 .تان قرار دهید با کلیک مجدد در پروژهرا از همان شی  دیتوان یمبعد از درج گره، با دو تکنیک فوق  

 .را کلیک راست نموده تا به عملیات خاتمه دهید تان پروژهاز محیط  ییجاهر  

اشیاء مختلف را در توپولوژی شبکه خود قارار   یها گرهلازم تکرار کنید تا  مراحل فوق را برای تمام اشیاء 

 .دهید
OPNET  از اشیاء کاربردی که در دنیای واقعی وجود ندارند را برای شابیه ساازی مهیاا     ییها مدلهمچنین
هاا  و کاربرد یا شابکه  یهاا  یتکنولاوژ جهت آسان نمودن مراحل تعریف و پیکربنادی   ها مدلاین . نموده است
 & Drag) از عمل کشیدن و رها کردن  دیتوان یمجهت اضافه نمودن این اشیاء به محیط پروژه . اند شدهطراحی 

Drop ) دیینمااستفاده. 
و  لینک، مسیر یها مدل قاز طری توانند ینم( Utility Objects) معمولی این ابزارها  یها گرهاما، بر خلاف 

Demand  و فقاط بارای    اناد  نشاده واقعی مدل  یا شبکهابزارها در هیچ تجهیزات به هم متصل شوند چرا که این
 .اند شدهاهداف خاصی توسط شما پیکربندی 

 (پیوندها) ها  Linkاضافه نمود  : ایجاد توپولوژی شبکه  .2-4-2

 :دیینمامراحل زیر را دنبال  ها گرهجهت اضافه نمودن پیوندهای ارتباطی بین 
 .کلیک کنید اش کونیآانتخاب نموده بر روی  Object Palette Treeمورد نظر را از  Linkمدل  
از طریق این پیوند به گره دیگر متصل کنید کلیک  دیخواه یمکه  تان پروژهمحیط بر روی اولین گره در  

 .نموده تا یک خط ارتباطی ظاهر شود
لین گره همین کاار را  مورد نظر بر روی او Linkبا کمک کشیدن و رها کردن مدل  دیتوان یمهمچنین شما 
 .انجام دهید

این عمل یک پیوند ارتباطی باین دو  . دیینماخط ظاهر شده را به گره دوم متصل کنید و بر روی آن کلیک 
 .دینما یمگره ایجاد 

 .انجام دهید ها گرههمین عملیات را برای ارتباط با سایر  دیتوان یمشما  

 .دیینماتان کلیک راست  ی از محیط پروژهو در آخر جهت خاتمه به عملیات فوق روی هر جای 



 

  

جهات  . ی بجای مسیر مستقیم بین دو نقحه ایجاد کنیاد حنیک مسیر ارتباطی من دیخواه یمبرخی اوقات شما 

انجام آن بر روی گره اول کلیک نموده سپس بجای کلیک روی گره مقصد، در جایی از بین دو گره در محیط 

انحنا ایجاد شود انجام دهید و ساپس در آخار بار روی     دیخواه یما آنجا که و این کار را ت. دیینماپروژه کلیک 

 .دیینماگره مقصد کلیک 

 ها حذف یک گره یا لینک: ایجاد توپولوژی شبکه  .3-4-2
علاوه بر ایجاد و اضافه کردن اشیاء به توپولوژی شبکه، گاهی ممکن است نیاز به حذف اشیاء ناخواساته از  

شما حذف یک گره باشد که لینکی به آن متصل است آن لینک نیز با هدف  اگر. باشید شبکه ایجاد شده داشته

 :وجود دارد OPNETدو راه جهت حذف اشیاء در . گردد یمحذف گره حذف 

 .بزنید صفحه کلیدرا روی  Deleteروش مورد نظر را کلیک نموده سپس دکمه  :‌1روش‌

 < Editor Project  Deleteساپس از مناوی کشاويی در    شی مورد نظر را با کلیک انتخاب نموده  :‌8روش‌

Edit  دیینمارا انتخاب. 

 سایر عملیات ویرایش: ایجاد توپولوژی شبکه .4-4-2
Project Editor        جهات انتخااب اشایاء    . نیاز به انتخاب یاک یاا چناد شای و انجاام عملیاات مختلفای دارد

 .دیینمازیر استفاده  یها کیتکن از دیتوان یم
اشایاء بیشاتری    Control- Clickیا  Shift-Clickسپس با  دیینمای مورد نظر را با کلیک انتخاب ش :‌1روش‌
 .(باشد یمبه همراه کلیک کردن  Controlیا  Shiftمنظور نگه داشتن . ) دیینماانتخاب  ها آنروی 

یل روی هر قسمت از محیط کار کلیک چپ نموده و سپس با کمک اشاره گر ماوس  یک مساتح  :‌8روش‌
 .شوند یمتمام اشیاء آن ناحیه انتخاب . دیینمابکشید و در انتها کلیک ماوس را رها 

به هر ناحیه از محیط کارتان انتقال دهیاد و ایان کاار را باا      دیتوان یماشیاء انتخاب شدند، شما این که بعد از 
ا روی اشیاء انتخاب شده چنین عملی ر Project Editorدر  Editمنوی . کشیدن و رها کردن ماوس انجام دهید

 Cut ( Ctrl+X) ،Copy(Ctrl+C) ،Paste (Ctrl+V) ،Undo (Ctrl+Z) ،Redo (Ctrl:  نظیار . دهاد  انجام می

+Y) 
  Rapid Configurationابزار  .5-2

این ابزار همچنین . باشد یممفید است با تعداد بالای تجهیزات  یا شبکه یها یتوپولوژاین ابزار جهت ایجاد 
 .باشد یم تر عیسر Project Editorاز بسیار 

  Rapid Configurationایجاد توپولوژی شبکه با کمک ابزار  . 2 -5 – 1
 :دیینماجهت انجام کار مراحل زیر را دنبال 

 .انتخاب کنیدرا  Rapid Configuration  > Topologyاز منوی کشويی گزینه  
را جهت  nextرا از لیست کشويی انتخاب و دکمه  پنجره ابزار ظاهر شد، توپولوژی مورد نظر که یزمان 

، Bus ،Full Mesh: باشاد  یما شاامل ماوارد زیار     Topology Configurationلیسات  . پیکربنادی آن بزنیاد  
Randomized Mesh ،Ring ،Star ،Tree ،Unconnected Net. 



 

 

-را مای اد تصادفی گره تصادفی برای تولید تعد یها گرهاجازه تعیین مقدار  Rapid Configurationپنجره 

جهت انجام . ره در شبکه داشته باشیدگکه شما نیاز به جایگذاری تصادفی  باشد یماین ویژگی زمانی مفید  .دهد
را   Generateرا تایپ نماوده دکماه   ( گره)   Seedمقدار  هدر پنجره باز شدو را کلیک نموده  Seedآن دکمه 

 .را بزنید OKس جهت تولید تصادفی اتوماتیک کلیک نموده سپ

کاه اجاازه تغییار     شاود  یمکلیک کنید یک پنجره جدید باز  Nextدکمه روی ژی وبعد از انتخاب توپول 

از شما در خصاوص تعیاین مادل بارای      Starدر توپولوژی . )دهد یممدل را  یها گرهو  ها نکیلپارامترهای 

مادل   یهاا  برگمیانی و  یها هگردر خصوص  Treeجانبی آن سوال شده و در توپولوژی  یها گرهمرکز و 

 .و سایر پارامترها ها گره، موقعیت ها گرهتعداد : مانند .( شود یمسوال 

 Select Modelsشامل مدل مورد نیازتان نباشد، آنگاه بر روی دکماه   ها نکیلگره و  یها ستیلچنانچه  

 .دیینماانتخاب ظاهر شده  یها مدلکلیک کنید و خانواده تکنولوژی مورد نیاز خود را از لیست 

شبکه و درج آن در محایط پاروژه    یتوپولوژجهت ایجاد  OKشدند روی دکمه  setتمام مقادیر  که یزمان

 .دیینماکلیک 

 Rapid Configurationباا کماک ابازار      Ethernet LANدر اینجا یک مثال جهات ایجااد   : مثال 0-۳-0

باه  ایستگاه کااری   3۳را با  Ethernet LANشبکه  که یک میا آورده Rapid Configurationکار با ابزار برای 

 :باشد یممراحل به شرح زیر . میینما یمدر مرکز آن ایجاد  Ethernet Switchگره و یک  عنوان

 . را از منوی کشويی انتخاب کنید  Project Editor  :Rapid Configuration > Topologyدر   

 Star  کمه توپولوژی انتخاب نموده و د به عنوانراNext  دیینمارا کلیک. 

 :دیینمادر پنجره جدید ظاهر شده، مقادیر زیر را تنظیم  
Center Node Model: Ethernet 16-Switch 
 Periphery Node Model: Ethernet- Wkstn 

Number : 15         عدد قابل افزایش است 3۳که تا  باشد یمجانبی  یها گرهتعداد                  Number  
Link Model: 10 Base T 

Center X=12     (عدد پیش فرض)   

Center Y=12       (عدد پیش فرض)  

Radius: 40      (عدد پیش فرض)         

 .دیینماکلیک  OKبر روی 

چنانچاه در انتخااب لیناک ارتبااطی انتخاابی      . دهاد  یمپنجره پیکربندی این ابزار مفید را نمایش  0-۳شکل 

هشاداری در ایان خصاوص باه      OPNETاشتباه کردید آنگاه امکان دارد که  ها گرهیا در تعداد  دیا نمودهاشتباه 

برخی اشتباهات رایج را آورده و جهات اجتنااب از آن و تاییاد اعتباار توپولاوژی راه       0-9-0بخش . شما بدهد

 .دینما یمارايه  ییها حل



 

  

 پیكربندي اشیاء ارتباطي .6-2

لایاه  )  data Linkاز طریاق لایاه    ها نکیل. دینما یمشبکه را به هم مرتبط  یاه گرهاشیاء ارتباطی پیکربندی 

 .دهند یمانجام  ها آنمتصل به  یها نکیلرا توسط  ها گرهکه تايید سازگاری  شوند یمتعریف ( 0

انتخاب خواهید کرد، برای  باشد یماغلب، شما یک مدل لینک که برای ایجاد توپولوژی مورد نظر مناسب 

باا سارعت    Point- To- Pointرا جهت اتصال دو گاره باا یاک لیناک      PPP-56Kشما شاید مدل لینک : مثال

56Kbps  اما در برخی شرایط، بعد از اینکه شما یک شی لینک در توپولوژی اضافه نمودید، آن . دیینماانتخاب

 .دیینمارا بایستی بر اساس نیازتان پیکربندی 

 

توپولوژی شبکه ( ب)  Starجهت ایجاد و توپولوژی   Rapid Configurationابزار ( الف) 2-5شکل 

 تولید شده توسط این ابزار

برخای از ایان   . اساسی متنوعی نظیار، نارخ انتقاال، سارعت انتشاار دارناد       یها یژگیولینک شامل  یها مدل

 اشاند ب یما  intیاا   Adv هاای  Modifierلیناک کاه شاامل     یهاا  مادل . روناد  یما پارامترها در شبیه ساازی بکاار   

(Advanced Intermediate )ًدهناد  یمبه شما اجازه تغییر پارامترهای عمومی نظیر نرخ انتقال لینک را  معمولا .

 Modifierاجازه تغییر نرخ انتقال بدون در نظر گرفتن  100Base-Tو  1000Base-Xنظیر  ییها نکیلاما، مدل 

 .دهند ینماستفاده شده در نام آن مدل را 

 اصلی لینک یها یژگیوتغییر  . 1-6-2
پیکربنادی شاوند جهات     توانند یمانتظار  ریتأخنقحه به نقحه نظیر نرخ انتقال و  یها نکیلاصلی  یها یژگیو

 .دیینماتغییر این پارامترها مراحل زیر را دنبال 

 .دیینمارا انتخاب  Edit Attributesکلیک راست نموده و گزینه  Linkروی شی 

 .دیینمادر گوشه پایین راست انتخاب را   Advanced Checkbox در پنجره باز شده، گزینه

تنظایم   Distance Basedپایش فارض باه مقادار      به طورکه  باشد یمقابل تنظیم  Delayانتشار با نام  ریتأخ 

محاسبه  Linkاتوماتیک بر اساس مسیر پیموده توسط  به صورتانتشار  ریتأخاین به معنی این است که . شود یم



 

 

تنظیم کنید، باید روی فیلد  ها گرهچنانچه شما بخواهید آن را مستقل از مسیر یا موقعیت . گردد یمدی و پیکربن

 .و عدد مورد نظر را تایپ کنید دیینمارا انتخاب  Editمقدار آن کلیک نموده ، 

لیناک قابال مشااهده     یهاا  مادل این ویژگی در تماام  . مشخ  شده است Data Rateنرخ انتقال با ویژگی 

 :آنگاه باشد ینمدارای ویژگی فوق  Linkچنانچه مدل . باشد ینم
تغییار   شامل کهبا همان نام تغییر دهید  ها نکیلجاری به سایر  از لینک( 1-0-۳طبق بخش ) ویژگی مدل را 

از مناوی   Editروی فیلد مقدار ویژگای فاوق و انتخااب گزیناه      این عمل با کلیک. شود intیا  Adv هایدهنده
ظاهر شاده در لیسات را بررسای و مادل ماورد نظار خاود را انتخااب          یها مدللیست . ان پذیر استکشويی امک

 (.باشد یم 0منظور تکنولوژی لایه )دقت کنید که مدل جدید از همان پروتکل لینک قبلی استفاده نماید . دیینما
 یهاا  نارخ یاا از  . دییا نمارا با مقدار مورد نظر پر نموده و بر اساس بیت بار ثانیاه تایاپ     Data Rateویژگی  
 .دیینمااز پیش تعریف شده موجود استفاده  یا داده
را  Edit Attribute یا محااوره و پنجاره   دیینماکلیک نموده و تغییرات را ذخیره  OKدر آخر روی دکمه  
 .ببندید

  Linkبررسی صحت ارتباط . 2-6-2
تاان کامال نخواهاد     ها ، توپولاوژی شابکه   Linkاز طریق  ها آنها بر روی صفحه پروژه و اتصال  با درج گره

ها وجود دارد که بایساتی رعایات شاود     ها و شرایط بر روی چگونگی ارتباط گره انواع مختلف محدودیت. شد
 . کار نخواهد کرد یبه درست تان یساز هیشب صورت نیادر غیر 

دو گاره بایساتی دارای    نوع لینک بایستی با نوع گره متصل شاده باه آن محابقات داشاته و هار      یبه طور کل
توانید یاک ایساتگاه اترنات را باا      برای مثال شما نمی. های قابل دسترس برای نوع لینک برقرار شده باشند واسط

در عاوض، شاما نیااز باه     . دییا نماباه هام متصال     FDDIیا یک  Token Ringیک سرور اترنت از طریق لینک 
هاا   های گره ها به واسط ار در زمان اتصال نامناسب لینکیک پیام هشد OPNET. داریداستفاده از لینک  اترنت 

در  گوناه  هماان . دهاد  نماایش مای   تانیبراانتخاب کنید   ، با این عنوان که نوع لینک را مناسب و محابق با واسط
 : پیام هشدار شامل دو گزینه است . دییفرما یمملاحظه  0 -9شکل 

 
 .گره ها به واسط هااتصال نامناسب لینک  2-6شکل 

Ass Link and Ports            موجب بروز رسانی مادل باا پاورت مناساب لیناک شاده و اتصاال باه گاره برقارار
 . گردد می

Add Link Without Assigning Ports     مدل با پورت مناسب لینک بروز نشده و لینک متصال شاده بالا
 . استفاده خواهد ماند



 

  

دهاد نظیار ایجااد     انتخاب درست لیناک مای   پیام هشدار جهت OPNETشرایط دیگری نیز وجود دارد که 
مانند اینکه شما تلاش در تغییر ویژگی مدل که قبلاً به یک گاره یاا شای ارتبااطی     )ای ناصحی   توپولوژی شبکه
 دییا نماای ایجاد شد، فکر خوبی است تا چک  توپولوژی شبکه که یزمانبرای این منظور، .( دییبنمامتصل است 

 اند یا خیر؟ پیکربندی شده یبه درست ها آنت که آیا تمام گره  و اتصالا

OPNET  یک ابزار ساده برای انجام این کار مهیا کرده است نام آنLink Connectivity نام دارد . 

 : باشد  مراحل کار با این ابزار به قرار زیر می

را فشاار   Ctrl + Lهاای   را انتخااب کنیاد یاا دکماه     Topology > Verify Linksاز منوی کشويی،گزینه  

 . نمایش داده خواهد شد( شکل )محابق  Check Linksاین عمل پنجره . دهید

توانیاد   شما همچنین مای . کلیک کنید OKدکمه روی را انتخاب و   Verify Linksدر این پنجره، گزینه  

 . دیینمادریافت  Check Linksتری در خصوص پنجره  اطلاعات کامل Helpبا زدن دکمه 

 All Link and Path are Connected'' متصال شاده باشاند پیاام     یباه درسات  ها  مام لینکت که یصورتدر 

Propevly  " در انتهای پنجرهProject Editor را دریافت خواهید نمود . 

هاا   دو لینک غیر صحی  تشخی  داده شده و لینک  ، همانند مثال فوق در شکلصورت نیادر غیر 

 : پیام زیر نمایش داده خواهد شد  خورند و قرمز علامت می ضرب دربا 
'' 2 Incorrect Links And Paths Were Found''  

 
 .باز شده است Verify Linksکه توسط ابزار  Check Linksپنجره ( الف) 2 -7شکل 

 
 .تشخیص داده شده است OPNETیک شبکه با دو لینک پیکربندی شده ناصحیح که توسط ( ب)



 

 

 : باشند  معمول برای اتصالات ناصحی  به قرار زیر می یها شکل( همانند شکل )  

 . کند اید بحوریکه پروتکل ارتباطی لینک را پشتیبانی نمی یک لینک به یک گره ارتباط داده 

 – Ethernet 4- Slip  8نظیار    IP، یک سرور اترنت را به طور مستقیم به یاک مسایریاب   وقتی برای مثال

Gtwy    با اساتفاده از لیناکPpp – DS1, Point – To – Point    ایان لیناک بالا اساتفاده      ،متصال کارده باشاید

 . نماید نقحه به نقحه را پشتیبانی نمی  SLIPماند چرا که سرور اترنت پروتکل  می

 . های موجود در یک وسیله متصل کرده باشید های بیشتر از تعداد واسط گره 

متصال کارده    Ethernet 16-Switchمانناد    هرتا پو 39سرور اترنت را باه یاک ساويیچ     02برای مثال وقتی 

ماند و آن چهار سرور متصل به آن به شابکه متصال    لینک بلا استفاده و غیر کاربردی می 0در این حالت . باشید

 . نخواهد شد

 Ethernet 4 Slipها نظیر  برخی از تجهیزات نظیر مسیریاب. یک لینک را به یک پورت اشتباه وصل کنید 

8 – Gtwyبناابراین احتماال دارد اشاتباهاً یاک     . کنناد  نوع واسط را به صورت چندگانه پشاتیبانی مای   ، چند

که این ارتباط بلا استفاده و غیر کااربردی خواهاد    دیینمالینک نقحه به نقحه را به یک پورت اترنت متصل 

اگر پاورت  )  .نماید خودکار واسط صحی  را برای ایجاد لینک انتخاب می به صورت OPNETعموماً، . ماند

اما تخصی  لینک اشتباه باه پاورت ممکان اسات در زماان اساتفاده از ابازاری نظیار         .( صحی  موجود باشد

Rapid Configuration  ( 0- ۳بخش . ) افتد یبنیز اتفاق 

 خرابي و رفع خرابي عناصر شبكه . 2 -7
 OPNET  اغلاب  . هیاا کارده اسات   ساازی م  رفع خرابی عناصر شبکه در زمان شبیه۱ یک ابزار جهت خرابی

مهم است که رفتار سیستم را در زمان خرابی یک یا چند لینک بدانیم و یا اگر یک گره کلیدی نظیار سارور یاا    

توان آن عنصر مورد نظار را از شابکه    واض  می به طور. ها آگاه باشیم یک مسیریاب خراب شود از رفتار سیستم

و سپس عنصر  حذف شده را مجادداً در شابکه    میینمارا مشاهده  سازی را انجام داده و نتایج حذف نمود و شبیه

 . میینماجایگزین 

بعلاوه، حذف و . باشد اما حذف و سپس اضافه کردن عنصر به توپولوژی شبکه یک کار دست و پا گیر می

ساازی عنصار    محالعه شرایط مورد نظر را نخواهاد داد چارا کاه در وساط شابیه      اجازهسپس اضافه کردن عناصر 

هاایش   خواهید بفهمیاد چگوناه یاک شابکه و پروتکال      شما می که یزمانذف و اضافه شده است، برای مثال، ح

 . نمایند قبل و بعد از خرابی و رفع خرابی رفتار می زمان هم

 . ای برای خرابی و رفع خرابی مهیا کرده است یک ابزار جداگانه OPNETبرای این منظور 

 . در شبکه وجود دارد ها آنع خرابی دو روش جهت عناصر خراب شده و رف

 : برای تمام شبیه سازی  Fail/Recover Objects : #1 روش



 

  

خواهید خراب نماوده و ساپس رفاع خرابای کنیاد باا کلیاک روی آن انتخااب          شی مورد نظر که را می 

 .( انتخاب کنید Shiftو  Ctrlخواهید با کمک  چنانچه چندین شی را می. ) دیینما

 Recover Selected Objectsیاا    Topology > Fail Selected Objectsافتادن، گزینه  از منوی پایین 

 . دیینمانظر انتخاب د را جهت خرابی یا رفع خرابی شی یا اشیاء مور

 .(انجام دهید Recoverیا   Failتوانید از طریق کلیک روی شکلک  همچنین عملیات فوق را می) 

 : سازی  های خاص در حین شبیه نرفع خرابی در زما۱ خرابی  2#روش 

Object Palette  دیینمارا باز . 

 Shared Object Palettes Group     را بااز نماوده ساپسUtilities     را انتخااب کارده آنگااهNode 

Models  را بیابید کهFailure Recovery Node  باشد آن میدر . 

 Failure Recovery Node  دیینمارا به محیط پروژه خود اضافه . 

 . را انتخاب کنید Edit Attributesروی گره مورد نظر کلیک راست نموده گزینه  

 Failure Andناام آن را  : تان تغییر دهید، برای مثاال   شاید بخواهید نام گره را جهت درک بهتر هدف

Recovery Node بگذارید . 

 . دیینماآن را باز  Link Failure/ Recovery Specificationویژگی  Fail/ Recover Linksجهت  
را انتخاب و بااز   Node Failure/Recovery Specification، ویژگی  Fail/ Recover Nodsو جهت  
 . کنید
، یک سحر در ویژگی مربوطه اضافه کنید برای مثال جهت خراب شادن   Fail/Recovery Eventبرای  
ثانیه، شما نیاز به تنظایم عادد    022ن ثانیه و سپس رفع خرابی شدن آن در زما 3۳2در زمان  Node – Qگره 

 . دارید 0به مقدار  Node Failure / Recovery Specificationسحرهای 
 : های فوق را باز نموده و مقادیر  هر سحر از ویژگی 

Name رفع خرابی ۱ گره و لینک جهت خرابی 
Time  خرابی و رفع خرابی 

Status  دیینماخرابی یا رفع خرابی را تنظیم . 
 دییا نمارفع خرابای تنظایم   ۱ خرابی  یها گرهرا برای  Node Failure Modeید شما بخواهید ویژگی شا 

 : باشند  که به قرار زیر می
 Node And Attached Links (های اتصال ها و لینک ایجاد خرابی در گره)  
 Node Only (ها فقط ایجاد خرابی در گره)  
 Attached Links Only (مقادار پایش فارض    ، هاای اتصاالی   ر لیناک فقط ایجاد خرابی دNode Only 
 .( باشد می

 . دیینمارا کلیک  OKدر پایان بعد از انجام تمام تنظیمات مورد نظر  



 

 

هایی که مقادیرشان تغییار   هایی دور ویژگی گره با دایره Failure Recoveryیک نمونه از پیکربندی  
 : استفاده کنید  از پیکربندی پیشنهادی فوق. دهد کرده است نشان می

150 S  200                           زمان خرابی S  زمان رفع خرابی                        Node _ 0  نام 

 ها  زیر شبكه . 2 – 8
OPNET کارده اسات کاه دارای یاک شای زیار        فراهمتان  سازی ها را نیز برای شبیه امکان ایجاد زیر شبکه

 . باشد ها و زیر شبکه می ها، لینک ر اشیاء نظیر گرهشبکه ویژه جهت نگهداری سای

سلساله مراتبای و زیار     باه صاورت  هاای شابکه خاود را     توانید گاره  شی می Subnetبا کمک گرفتن از شی 
  Parent باه عناوان   Aشاود آنگااه زیار شابکه      Bشامل زیر شابکه   Aچنانچه زیر شبکه . ای طراحی کنید شبکه

Subnet  زیر شبکهB شود و  شناخته میB به عنوان Child Subnet خواهد شد . 
ای از چندین شی زیار شابکه ایجااد نماود کاه دو ساح         توان سحوح مختلفی از سلسله مراتب زیر شبکه می

 . است تر بزرگنمایانگر یک بخش فیزیکی یا منحقی از شبکه 
شود زیر شبکه  اخته میشن Global Subnetیا  Top Level به عنوانبالاترین سح  سلسله مراتب زیر شبکه 

که یک دسترسی سریع و آسان باه   یا به گونههای پیچیده بوده  سازی یک ابزار قدرتمندی برای مدیریت شبکه
 . سازد مهیا می تان یبراهای مختلف شبکه را  بخش

 
  Failure Recoveryیک نمونه پیکربندی گره  2 - 8شکل 

هاا   هاا اولاین تقاضاای شارکت     ریت توپولوژی به زیر شابکه کنید، مدی های بزرگ کار می با شبکه که یزمان

سپس بایساتی هرکادام از   . اضافه کنید۱ تان ایجاد برای هر زیر شبکه Subnetاول شما بایستی یک شی . باشد می

، دییا نماهای دیگار پار    ها و شاید هم زیر شبکه ها، لینک ای نظیر گره های تولید شده را با عناصر شبکه زیر شبکه

سازی بوده و بناابراین بایساتی فقاط یاک باار       مسئول پیکربندی تمام محالعه شبیه (Utility Objects)اشیاء ابزار 

 . گیرد ها این عمل انجام می Child Levelو یا در یکی از  Top Levelاضافه شود و معمولاً در سح  



 

  

  Subnet Objectاضافه نمود   . 1-8-2
  Editor Projectاز بخش  :#‌1روش‌

 . را انتخاب کنید Topology > Subnetمنوی پایین افتادنی آن ، از  

 :  دیینماهای زیر را انتخاب  از زیر منوی باز شده، یکی از گزینه 
Create Fixed Subnet : در  ییجا جابههایش اجازه  نماید که گره موجب ایجاد یک زیر شبکه فیزیکی می

باشند و معمولاً از طریق یک یاا چناد لیناک فیزیکای باه       می Static های سازی ندارند و نماینده شبکه حین شبیه
 . شوند ها متصل می ها زیر شبکه سایر گره

Create Logical Subnet  :های توپولاوژی فیزیکای نظیار     یک زیر شبکه مجازی یا منحقی جدا از ویژگی
هاا و زیار    چناد لیناک باه گاره    های منحقی نیز از طریق یک یا  کند، زیر شبکه موقعیت گره جغرافیايی ایجاد می

 . شوند های دیگر متصل می شبکه
 Create  Mobile Subnet  :       هاا در حاین    گاره  ییجاا  جاباه موجاب ایجااد زیار شابکه متحارک و قابال
هاا یاا زیار     های درون آن اجازه اتصال به سایر گاره  های متحرک و گره البته زیر شبکه. گردد سازی می شبیه
 . ای فیزیکی ندارنده ها را از طریق لینک شبکه
 Create Satellite Subnet  :کناد، همانناد    ای ایجاد مای  یک زیر شبکه ماهوارهMobile Subnet   ، هاا

هاا   ها یاا زیار شابکه    های فیزیکی به سایر گره توانند از طریق لینک های درونشان نمی ها و گره این زیر شبکه
 . متصل شوند

خواهید شای زیار شابکه     تان که می روی محلی از محیط پروژه حال بعد از انتخاب یکی از موارد فوق بر 
در خصاوص ناام جدیاد شای اضاافه شاده از شاما          OPNETهاای   برخای نساخه  ) دییا نمااضافه شود کلیک 

  (.پرسد می
خواهید را با طی مراحل فوق اضافه نموده و در آخر با کلیک راست بار روی   هر تعداد زیر شبکه که می 
 . تان به کار خود پایان دهید ژهای از محیط پرو ناحیه
  Object Paletteاز قسمت ‌2#روش‌

 Object Palette  باز کنید 0-1-3را همانند بخش . 
در  (باشاد  این آیکون می Object Paletteکه در سمت راست پنجره )های زیر شبکه را  یکی از آیکون 
  .تان کشیده و رها کنید از محیط کاری پروژه ییجاهر 

 . باشد می Fixed Subnetدارد همان  Subnetآیکونی که نام  نکته اینکه
تاان را انتخااب    البتاه ناوع زیار شابکه    )  دیینماتوانید تعداد بیشتری زیر شبکه با روش فوق اضافه  شما می 
 .( کنید
 . دیینمااز محیط کاری پروژه خود کلیک راست  ییجادادن به کار خود هر   و جهت خاتمه 

 سلسله مراتب شبکه حرکت در  . 2- 8 - 2
سلسله مراتبی با کمک زیر شبکه ایجاد شده است باه یکای از    به صورتورود به هر بخش از زیر شبکه که 

 . گیرد زیر انجام می یها روش



 

 

 کلیک بر روی آیکون زیر شبکه  دوبارهبا  :1روش‌
هر شاده آیکاون   از منوی ظا Enter Subnetکلیک راست روی آیکون زیر شبکه و انتخاب گزینه  :8روش‌
 زیر شبکه 

-از یکای از روش ( در سلسله مراتاب  حرکت به سمت بالا)  Parentدر پجهت حرکت به سمت زیر شبکه 

 :های زیر استفاده کنید
از مناوی   Go To Parent  Subnetاز محیط کاری و انتخاب گزیناه   ییجاکلیک راست روی هر  :1روش‌
 ظاهر شده 
 در جعبه ابزار  Go To Parent Subnetکلیک روی آیکون   :8روش‌
را انتخااب   View > Subnets > Go To Parent  Subnetاز منوی پایین افتاادنی اصالی گزیناه      :‌4روش‌
 . کنید

 . را با هم فشار دهید Ctrl + Qهای  دکمه :‌3روش‌
 IPم بناا  Top Levelرا کاه در آن   0 – 6برای مثال، در نظار بگیریاد توپولاوژی نماایش داده شاده شاکل       

 . نهاده شده است Cloud – Modelingشناخته شده است و نام این سناریو 

‌
  Top Levelشبکه سطح بالا ( الف)ها  مثالی از توپولوژی شبکه با زیر شبکه  2-9شکل 

 
 Client – Site3زیر شبکه ( ب)ها  مثالی از توپولوژی شبکه با زیر شبکه  2-9شکل 



 

  

 Client – Site5تاا   Client – Site1هاای  زیار شابکه بناام    ۳شاامل   0-6 (الاف )این توپولوژی طباق شاکل   
 . ندهست اینترنت مدل شده است متصل به عنوانای  به گره ها آنباشد و تمام  می

ایان   باه  غیر فعال شده است  Go To Parent  Subnetآیکون بینید می (الف) 0- 6در شکل که  گونه همان
یاک زیار شابکه     (ب) 0 – 6باشاد و در شاکل    موجاود نمای   Top Levelدلیل است که هیچ  زیر شبکه باالای  

Clinet – Site 3 توجه کنید که در تصویر سمت راست، آیکون . دهد از سناریو را نمایش میGo To Parent 

Subnet فعال است . 
 Topنمایاد کاه هماان     با کلیک بر روی این  آیکون در محیط کاری پروژه به سح  والد خود برگشت می

Level  باشد می (الف) 0 – 6شکل . 

 ها  با زیر شبکه  ایجاد یک توپولوژی شبکه .2 -8 – 3
 . در سح  اولیه شبکه، یک گره، لینک و اشیاء مورد نیاز خود را اضافه کنید 
یک زیر شی شبکه برای هر زیر شبکه مورد نیااز  باید هایی باشد آنگاه  اگر سح  شبکه شامل زیر شبکه 
 . دیینمااضافه 
 . دیینمابرای هر شی زیر شبکه یک توپولوژی شبکه ایجاد  
 . وارد زیر شبکه شوید 
 Objectیک توپولوژی شبکه درون زیر شبکه با کمک کشیدن و رها کردن اشیاء مورد نیااز از جعباه    

Palette  ( 2.3بخش ) و یا از ابزار   دیینماایجادRapid Configuration  ( 0-۳بخش ) دیینمااستفاده . 
 . های فرزند مراحل زیر را انجام دهید هت ایجاد ارتباط اشیاء در زیر شبکه والد به اشیاء زیر شبکهج 
 وارد زیر شبکه والد شده  
 . دیینمایک لینک جهت اتصال گره مورد نظر در زیر شبکه والد به زیر شبکه فرزند اضافه  
های شامل شاده   که لیست تمام گره شود باز می Select Nodeبا اتصال یک لینک به زیر شبکه، پنجره  

 . در زیر شبکه فرزند است
خواهیاد اتصاال باه آن برقارار کنیاد را انتخااب        ای را که می از لیست پایین افتادنی در پنجره فوق، گره 

 . را بزنید OKکرده  دکمه 
بکه که دیدید جهت برقراری ارتباط یک گره در یک زیر شبکه باه گاره دیگار در زیار شا      گونه همانپس 

توانیاد اضاافه    نظر خاود را مای  د به زیر شبکه والد داشته و سپس فقط لینک مور ییجا جابهوالد، شما اول نیاز به 
مشابه جهت ایجاد اتصال به دو یا بیشتر زیر شبکه فرزند، کافی است مراحل فوق را چند بار تکرار  به طور. کنید

 . دیینمابروید و از آنجا کار را شروع  (Top Level)کنید البته ابتدا بایستی به زیر شبکه والد 

 ها  اشیاء بین زیر شبکه یجا جابه . 2- 8 – 4
های مختلف در سح  سلسله مراتبی یکساان مراحال زیار را     اشیاء موجود بین زیر شبکه یجا جابهبه منظور  

 : دنبال کنید 

 . را چنانچه نمایش نیافته است اضافه کنید Subnetآیکون  

 . دیینماخواهید به زیر شبکه جدید انتقال یابند را انتخاب  یکه م ییایاش 



 

 

را از مناوی   Move Selected Nodes Intoبر روی آیکون زیر شابکه کلیاک راسات نماوده و گزیناه       

 . ظاهر شده انتخاب کنید

 : اشیاء از زیر شبکه فرزند به زیر شبکه والدش عملیات زیر را انجام دهید  یجا جابهبه منظور  

 . نظر جهت انتقال را انتخاب نمودهد ء موراشیا 

  Topology > Subnets > Move Selected Nodes Into Parentساپس از مناوی اصالی گزیناه      

Subnet  
 : اشیاء موجود پیرامون سلسله مراتب زیر شبکه عملیات زیر را انجام دهید  یجا جابهبه منظور  

 نظر جهت انتقال د انتخاب اشیاء مور 

را  Topology > Subnets> Move Selected Nodes Into Specific Subnetلی گزیناه  از منوی اصا  

 . دیینماانتخاب 

ها به آن منتقال شاوند را انتخااب نماوده      خواهید گره ای که می ، زیر شبکهChoose Subnetو از پنجره  

 . را بزنید OKدکمه 

ممکن اسات اشایاء را در روی    Editorچرا که کنید مراقب باشید  می جا جابهاشیاء را  که یزمانشما بایستی 

 . هایی که قابل دیدن نیستند قرار دهد اشیاء دیگر قرار داده و یا  در محل

 Zoom In/Out  یینماا و کوچاک   یینماا به منظور دیدن اشیاء انتقال یافته، شما ممکن است نیاز به بزرگ 

 Projectآیکون سامت راسات گوشاه پنجاره      بعلاوه، کلیک چپ بر روی. تان داشته باشید محیط کاری پروژه

Editor دهاد   های درج شده را نمایش مای  یک بخش کوچک که کل محیط کاری پروژه  و موقعیت تمام گره

 . نماید نمایان می

هاا   ویژگی OPNETدر .  کند و با کلیک چپ دیگر بر روی همان آیکون این بخش کوچک را مخفی می

ایان امکاناات   . باشد که خارج از حیحه این کتاب است ها موجود می ر شبکهو امکانات پیشرفته دیگری برای زی

 . آورده شده است OPNETدر مستندات 

 توپولوژي ( یادداشت) ایجاد حاشیه نویسي  . 2- 9
باشد که کمک به سازماندهی بهتر توپولوژی شبکه  شامل یک ابزار حاشیه نویسی می OPNETمحصولات 

دهاد کاه اشایاء     ابزار فوق به شاما ایان امکاان را مای    . نماید رافیکی مختلفی ایجاد مینماید و نکات متنی و گ می

های مختلف بکشید و یاا اشایاء را باا     ها با رنگ ها، مستحیل گذاری نموده؛ خحوط، دایره درون شبکه را برچسب

 . دیینمانظر پر د ها مور رنگ
شاود کاه    پانج شای را شاامل مای     Annotationایان جعباه   . کنید مشاهده می 0-32که در شکل  گونه همان
 : باشند  به اشیاء به قرار زیر می دیینماتوانید در توپولوژی شبکه خود در محیط کاری درج  می



 

  

به شما امکان درج یاک مساتحیل یاا شاکل بیضاوی دار در محایط       :  (Box , Ellipse)ای‌‌‌اشیاء‌بیضی‌و‌جعبه 
متفااوت   یهاا  یژگیوموقعیت مکانی، چرخش و  ،ها رنگ ،ندازها توانند یماین اشیاء . دهد یم تان پروژهکاری 

 .داشته باشند
مختلف از لحاظ رنگ، موقعیت، فلش در ابتادا یاا    یها یژگیوجهت کشیدن خحوط با :  Line اشیاء‌خط 

 .روند یمبکار ( هاشور دار یا پر) انتهای خط، استیل خاص مانند 
، دهااد یما پاروژه را   یهااا تمیا آن توضاایحات متنای باه   باه شااما امکاان اضاافه نماود     (‌:Text)‌اشيیاء‌ميتن‌‌‌ 
 .است... شامل، اندازه فونت، رنگ متن، موقعیت و  شانیها یژگیو

 .دهد یم Project Editorرا در  OPNETبه شما امکان درج هر آیکونی از  (‌:Icon)‌اشیاء‌شكلی‌ 

 
 Annotationجعبه  2-11شکل 

 0-6-3 یها شکل، باشد یمتوضی   -، خودAnnotationعبه هر چند اکثر عملیات انجام شد جهت کار با ج
 .را مهیا کرده است Annotationیک توصیف مختصری از عملیات کلیدی جعبه  0-6-1الی 

یک مثال از توپولوژی شبکه به همراه حاشیه نویسی اشیاء اراياه داده   #0در آزمایشگاه تمرینات  0-3شکل 
 .است

 به محیط کاری پروژه Annotationبه اضافه نمود  اشیاء جع .2- 9 – 1
از مناوی پاایین    Open Annotation Palette > Topologyرا باا انتخااب گزیناه     Annotationجعباه   

 .دیینماباز  Project Editorافتادنی پنجره 
 :تا بر روی پروژه تا اضافه شود دیینمامورد نظر کلیک  Annotation شی روی 
 .بکشید تان پروژهپیرامون شی را به صفحه (عنوان)، یا جعبهبیضی و  یها یشبرای  
( در محل مورد نظر جهت شاروع خاط  ) کلیک چپ نموده  تان پروژهبرای اشیاء خط و در محیط کاری  

 دوبااره و به همین روش خحوط دیگری را بکشاید و در آخار باا    . دیینماک چپ یو سپس در نقحه پایان کل
 .ن دهیدکلیک کار مجموعه خحوط کشیده شده را پایا

 با کلیک دیتوان یم دیخواه یمشما به هر تعدادی که . ک راست عمل کشیدن خحوط را پایان دهیدییا با کل
 .دیینماچپ، خحوط لازم را رسم 

خودکار یک ویرایشگر بارای تایاپ ماتن     به صورت OPNETبا اضافه نمودن یک شی متن ،  30در نسخه 
از  Commit > Fileن یافات پنجاره ویرایشاگر را باا انتخااب گزیناه       عمل تایپ متن پایا که یزمان. دینما یمباز 

سپس قسامت  (. یا به کمک دکمه سمت راست بالای پنجره این عمل را انجام دهید.) منوی پایین افتادنی ببندید
 تار  یمیقاد  یها نسخه. آنجا اضافه کنید، بکشید دیخواه یمتان محلی که  به محل داخل پروژه را textعنوان شی 

 .ید ابتدا از شما بخواهند که عنوان شی را تایپ نموده سپس به شما اجازه اضافه نمودن و تایپ متن را بدهندشا



 

 

در محیط کاری پاروژه در محال ماورد نظار ایان کاار را        به سادگی با کلیک چپ: ی اشیاء آیکون برا 
 .انجام دهید

 .ت به عملیات خود خاتمه دهیددر انتها کلیک راس .عملیات فوق را به تعداد دلخواه انجام دهید

  Annotation اشیاء جعبه یها یژگیوتغییر و ویرایش . 2- 9 – 2
در محیط کاری پرونده پروژه بر روی شی ماورد   Annotationهر شی از جعبه  یها یژگیوجهت ویرایش 

 .میکن یمرا انتخاب  Edit Attributesنظر کلیک راست نموده و از منوی ظاهر شده گزینه 
 :باشد یمشامل موارد زیر  رندیگ یماشیاء بیضی و جعبه که اغلب مورد استفاده قرار  یها یگژیو 

Color  :تعیین رنگ شی 
File  : یش  پرکنندهتعیین رنگ 

Width/Height  :تعیین ابعاد شی 
Rotation  : دهد یماجازه چرخش شی به مقدار درجه مورد نیاز  

 :عمومی اشیاء خط یها یژگیو 
Color :یین رنگ شیتع 

Drawing Style : گزینه خحوط را با کمک انتخاب  یها بخشاجازه صاف نمودنSpline این ماورد   برای

 .دهد یم

Line style  :باشد یمصورت خط تیره یا خحوط پر ه تعیین نوع خحوط ب. 

Head Arrow / Tail Arrow  :تعیین نوک فلش ابتدا یا انتهای خط 

 :های عمومی اشیاء متنویژگی 

Color  :رنگ متن 

Font  :نوع فونت 

Background Color  :رنگ پس زمینه 

Rotation :چرخش متن به اندازه درجه دلخواه 

 :عمومی اشیاء آیکون یها یژگیو 

Icon Name : باشد یمجهت تعیین نام آیکون نمایش یافته در محیط کار پروژه. 

ر بر روی این ویژگی کلیک کنید، یک پنجره باز شده تایپ کنید بلکه اگ ماًیمستقتوانید نام آن را شما نمی

 .دهد یمو به شما اجازه انتخاب آیکون مورد نظر را 

  Annotationمخفی نمود  اشیاء جعبه / نمایش .3-9-2
در محایط کااری پاروژه از مناوی پاایین افتاادنی        Annotationمخفای نماودن اشایاء جعباه     ۱ نمایشجهت 

Project Editor  گزینهShow In Subnet  > Annotation > View  کاه ایان گزیناه ماابین     . را انتخاب کنیاد

 .دهد یمنمایش دادن و مخفی شدن اشیاء تغییر وضعیت 



 

  

 حذف درهم ریختگي .11-2
OPNET شابکه کاه    یها یتوپولوژجهت حذف درهم ریختگی و روی هم افتادگی  دارای، چندین امکان

یست زیر هر کدام از این امکانات را توضی  داده و نحوه استفاده از ل .، استباشد یمدارای تعداد زیادی آیکون 
 .کند یمرا بیان  ها آن

 Automatic Icon Scaling‌: به صورت رندیگ یمخیلی نزدیک به هم قرار  که یزمانرا  ها کونیآاندازه 
از مناوی پاایین    جهت فعال غیر فعال ساازی ایان ویژگای   . روی هم نیافتند ها آنتا  ،دینما یمخودکار تنظیم 
ایان گزیناه   . دییا نمارا انتخااب   Project Editor Automatic Icon scaling > Layout > Viewافتاادنی  

نیاز   Disable Iconتوسط تغییار مقادار   .( مشاهده شود 3-0بخش )  Preference Editorاز طریق  تواند یم
 .انجام گیرد

 Authorizing : ایان  . دیا نما یما در محایط کااری را تنظایم     ها ونکیآاین ویژگی به طور خودکار اندازه

پیش فرض و خودکار، زمانی که تعداد  به طورمنفی بگذارد لذا  ریتأثبر کارايی شبیه سازی  تواند یمویژگی 

از  تاوان  یما این سح  آساتانه را  . گردد یم فعال ریغ شود یمبیشتر  یا آستانهپروژه از یک سح   یها کونیآ

 Element Count Threshold For Aggressiveبا تغییر مقدار گزیناه   Preference Editorطریق بخش  

Icon Authorizing باشد یم ۳22عدد پیش فرض . تغییر داد. 

 Automatic Label Placement‌ :   کاه موجاب کااهش در هام      باشاد  یما این ویژگی گزیناه دیگاری

اتوماتیاک برچساب اشایاء انجاام      این عمال را توساط درج   ،گردد یمریختگی توپولوژی شبکه ایجاد شده 

جهت فعال سازی این ویژگی گزینه . افتند ینمبنابراین اشیاء یکدیگر را پوشش نداده و بر روی هم . دهد یم

View>Layout>Automatic>Label Placement  از طریااق  توانااد یمااایاان ویژگاای . دییاانمارا انتخاااب

Preferences Editor نیز تنظیم گردد. 

 .شود یماین عمل با تغییر مقادیر زیر انجام (. دیینماعه مراج 3-0به ) 

 Title _ Autoplacing _ Rty _ Smal _ Font‌‌: جهات جلاوگیری از    تر کوچک یها برچسباستفاده از

 افتادگی اشیاء هم یرو

 Title _ Autolacing .Directions‌:  باه  ( چاپ، راسات   -پاایین  -باالا ) در نقاط مختلف  ها برچسبدرج
 افتادگی اشیاء هم یرولوگیری از منظور ج

 Title_Autoplacing .disable‌:  ها برچسبجهت تغییر وضعیت درج اتوماتیک 
 Intracting Icon Scaling  : ها کونیآدستی اندازه  به صورتکه شما بتوانید  شود یماین ویژگی موجب 

نکارده باشاید ایان ویژگای بار روی       چنانچه هیچ شی را انتخاب. تغییر و تنظیم کنید تان پروژهدر محیط کاری 
فقط بر روی اشیاء انتخاابی اعماال    صورت نیادر غیر . خواهد بود رگذاریتأث تان پروژهتمام اشیاء محیط کاری 

 :جهت استفاده از این ویژگی گزینه زیر را انتخاب کنید. شود یم
View > Layout > Scale Node Icons Interactively   



 

 

 

آزمایشگاه 

2 
 ه ریزی ظرفیت سادهبرنام

 
 

 .شود یم توصیه 0 تا 3 فصول خواندن آزمایشگاهی تمرین این برای

1-2L. مقدمه 
 تقاضااهای ترافیکای   همچناین  و شابکه  عملکارد  در لیناک  ظرفیات  یرتاأث  شما تمرین آزمایشگاهی، این در

 خااص،  طاور  باه . دنماییا  یما واحد مشخ   ویژگی یک برای متعددی مقادیر و نمایید یم  بررسی را پیکربندی

 نماید یم را توصیه محلوب پیکربندی نموده یک ارزیابی مختلف شرایط تحت شده را داده شبکه عملکرد

 خواهاد  یما  و رشاد باوده   روند در کوچک، خصوصی شرکت یک ،ABC :بگیرید نظر در را زیر وضعیت

را  آینده در جدید دفتر دن اندازهنمو برابر دو قصد شرکت این. شهر اضافه نماید دیگر انتهای در دیگر دفتر یک

 تاأمین  را بارای  گزینه بهترین ABC برای شرکت که کرد خواهد کمک شما به آزمایشگاهی، تمرین این. دارد

 .اینترنت داشته باشید به دفاترش اتصالی لینک

2-2L .مدل سازي شبكه شرکت شبکه ABC  
(. 3-9-0 بخاش ) ترتیب ایجاد نمایید به ،ABC_ Network و 20 نام به خالی سناریوی و جدید پروژه یک

 یهاا  مدل از که کنید حاصل اطمینان. است را ایجاد کنید شده داده نشان L2-1 شکل در که شبکه توپولوژیو 

 که هنگامی. یدا نمودهاستفاده  شده مشخ ( 0-0 بخش در دستورالعمل دنبال به) L2-1 جدول در لینک و گره

 (0-9-0 بخش. )کنید بررسی لینک را، اتصال شد ایجاد شبکه توپولوژی

 _IP تقاضاای  مادل  چهاار  و( 9-9 بخاش ) تقاضااهای ترافیاک   پیکربنادی  و کاردن  اضافه به نیاز شما بعد،

Traffic_ Flow    پیکربندی نمایید زیر شرح بهرا: 

 ( Traffic Mix) ری صا  ترافیاک  عناوان  مدل شاده باه   ترافیک درصد 3 برای داشتن باید تقاضاها همه 

 .کربندی گرددپی

 .شروع نمایند ثانیه 322 زمان را در ها داده انتقال باید تقاضاها همه 

 .دهد ادامه سازی شبیه پایان تا داده به انتقال باید تقاضاها همه 

 ثابات  نارخ  باید باا  IP تقاضاهای  New Office → DB Server و   Main Office → DB Server دو هر 

 .را انتقال دهند ها دادهثانیه  هر در بسته 322 و ثانیه بر بیتو کیل 3022



 بایاد باا   IP تقاضااهای   New Office → E-Mail Server و    Main Office → E-Mail Server دو هار  

.را انتقال دهند ها دادهثانیه  هر در بسته 32 و ثانیه بر بیتو کیل 922 ثابت نرخ

 .تمرین این برای شبکه توپولوژی L2-1 شکل
 ABC Inc.’S Network Topologyای‌از‌خلاصه‌‌8L–‌1جدول‌

Object Model Object Name 
Ethernet_Server Node ObjectDB Server
Ppp_Server Node ObjectE-Mail Server
1000basex_LAN Node ObjectMain Office

New Office
Ethernet4_Slip8_Gtwy Node 
Object

ABC Router
New Router

Ip32_Cloud Node ObjectThe Internet
1000basex Link ObjectMain Office <-> ABC Router DB Server 

<-> ABC Router New Office <-> New 
Router

PPP_DS1_Int Link ObjectABC Router <-> The Internet
New Router <-> The Internet

PPP_DS3 Link ObjectThe Internet <-> E-Mail Server

3-2L. شرکت شبکه بررسی ABC
:انجام دهید زیر آمار آوری جمع برایرا  تان یساز شبیه پیکربندی

(.9-9 بخش) تقاضا این آمارهای تمام 
 (.0-0-1 بخش)  Category Point-To-Point در پیوند این آمارهای تمام 

 جماع  آمارهاای  بررسای  آن باه  از پس و( 0-1-2 بخش)انجام داده  ساعت 3 مدت به را سازی شبیه اجرای
(:0-۳ بخش)بپردازید  شده آوری زیر

.ترافیکی یها خواسته از یک هر توسط شده فرستاده ترافیک 
.The Internet گره به متصل های ینکل میزان مصرف تمام 
.تقاضا نقاط از یک هر توسط شده دریافت ترافیک 
 .تقاضا یها بسته توسط شده تجربه انتهای  -به - ها یراتتاخ 



 عناوان  باه ) نکنیاد  صراحت پیکربندی به ترافیک ایجاد برایرا  خود یها خواسته اگر که باشید داشته توجه 
گازارش   یا داده هایچ  و ،(نشاده باشاد   تنظایم  ٪2 از تار  بازرگ  مقادار  یاک  به را Traffic Mix ویژگی مثال،

 .نخواهد شد

4-2L. افزار نرم عملکرد مقایسه
ایجااد   (3-2 بخاش )  Eliminating Bottleneck نام به سناریوی جدید یک پی بگیرید ورا ک اصلی سناریوی

ر مقادا  مقدار تنظیم شاده اسات کاه    ینتر کوچک به گلوگاه های ینکل ظرفیت تعیین جدید، سناریوی در. کنید
 Data  ویژگای  حااوی  لیناک  جسام  اگار  که باشید داشته توجه. نماید یم ٪92 حدود مصرف لینک گلوگاه را

Rate  ،حااوی پساوند   که یکی به لینک مدل تغییر به نیاز شما آنگاه و است، لینک ظرفیت دهنده نشان که باشد 
_Int ابتادا   ،شی ماورد نظار   با ارتباط در مدل تغییر برای. خود باشد دارید نام درAdvanced Checkbox  در را 
از  پاس   .(1-0-۳ بخاش ) را تغییر دهید Model ویژگی  مقدار سپس نمایید و  انتخاب Edit Attributesپنجره 
شاده   آوری جمع آمارهای  به بررسیو نمایید   اجرا مجدداًرا  سازی شبیه ،گلوگاه لینک روز رسانی ظرفیت به

 .بپردازید

5-2L. بهینه هزینه/  باند نرخ پهنای شناسایی
. ایجااد نماییاد   (3-2 بخاش )      Best Optionناام   باه  جدید یک سناریوی Eliminating Bottleneck سناریو
 میازان  شادن ر برابا  دو باه  منجر که کرده، برابر را دو ادارات خود جدید کارکنان ABC شرکت که کنید فرض
 ازناشای  تقاضااها   ترافیاک  انتقاال  نرخ رفتاری، کردن چنین مدل برای. باشد یمدفاتر  این از شده تولید ترافیک
.نمایید برابر دو را New Office گره
:دهد یم  ارايهاینترنت  به اتصال برای را زیر های ینهگز( ISP) اینترنت خدمات دهنده ارايه حاضر، حال در

ماه هر در دلار T1 ۳2 خط 
ماه هر در دلار 322 ثانیه در بیتا مگ خط 0 
ماه هر در $ 3۳2 ثانیه در بیتا مگ خط 32 
ماه هر در دلار ۳22 ثانیه در بیتا مگ خط ۳2 
 نارخ  باه  را یافتاه ارتقااء   ویژگای  مقادار  ساپس  دهید و ارتقاء گلوگاه را لینک روی بر Data Rateویژگی 
ا مگا  ۳2 و ثانیه در بیتا مگ 32 ثانیه، در بیتا مگ DS1، 4 یا T1 مثال، عنوان به) ISP طریق از اینترنت دسترسی
 و مصرف لیناک گلوگااه   یزانم و اجرا نموده مجدداًرا  خود سازی شبیه. تنظیم نمایید( 1-۳ بخش) ثانیه در بیت
را               New Office گاره  از ناشای  IP تقاضااهای هاای   از اطلاعااتی  یهاا  بساته  توسط شده تجربه انتها به انتها یرتأخ

 .بررسی نمایید



کتاب شامل 432  صفحھ است کھ 
فایل الکترونیکی آن را می توانید 

از سایت کتابراه تھیھ کنید. 
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